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Safety warning notice

WARNING! To reduce the possibility of heat-related injuries or of overheating the computer, do not
place the computer directly on your lap or obstruct the computer air vents. Use the computer only on
a hard, flat surface. Do not allow another hard surface, such as an adjoining optional printer, or a soft
surface, such as pillows or rugs or clothing, to block airflow. Also, do not allow the AC adapter to
contact the skin or a soft surface, such as pillows or rugs or clothing, during operation. The computer
and the AC adapter comply with the user-accessible surface temperature limits defined by the
International Standard for Safety of Information Technology Equipment (IEC 60950).
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1 Product description

Category Description

Product Name HP EliteBook 8560w Mobile Workstation

Processors Intel® Core™i7 processors

 i7-2860QM, 2.50GHz (Turbo up to 3.60GHz), quad-core processor, 8MB
L3 Cache, 8 threads, 45W

 i7-2820QM, 2.30GHz (Turbo up to 3.40GHz), quad-core processor, 8MB
L3 Cache, 8 threads, 45W

 i7-2760QM, 2.40GHz (Turbo up to 3.50GHz), quad-core processor, 6MB
L3 Cache, 8 threads, 45W

 i7-2720QM, 2.20GHz (Turbo up to 3.30GHz), quad-core processor, 6MB
L3 Cache, 8 threads, 45W

 i7-2670QM, 2.20GHz (Turbo up to 3.10GHz), quad-core processor, 6MB
L3 Cache, 8 threads, 45W

 i7-2630QM, 2.00GHz (Turbo up to 2.90GHz), quad-core processor, 6MB
L3 Cache, 8 threads, 45W (not configurable with iAMT)

 i7-2640M, 2.80-GHz (Turbo up to 3.40), dual-core processor 3-MB L3
cache, 4 threads

 i7-2620M, 2.70-GHz (Turbo up to 3.40), dual-core processor 4-MB L3
cache, 4 threads

 Intel Core i5 processors

 i5-2540M, 2.60-GHz (Turbo up to 3.30), dual-core processor, 3-MB L3
cache, 4 threads

 i5-2520M, 2.50-GHz (Turbo up to 3.20), dual-core processor, 3-MB L3
cache, 4 threads

Chipset Mobile Intel QM67 chipset

Graphics NVIDIA Quadro 2000M

 NVIDIA Quadro 1000M

 AMD FirePro M5950

 OpenGL Driver Support

Panel All display assemblies include 3 wireless local area network (WLAN)
antennas and 2 wireless wide area network (WWAN) antennas

 39.6 cm (15.6 in) High-Definition Plus (HD+) AntiGlare (AG) LED WVA
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Category Description

 39.6 cm (15.6 in) HD+ AG LED WVA with webcam

 39.6 cm (15.6 in) FHD AG LED WVA

 39.6 cm (15.6 in) FHD AG LED WVA with webcam (for use with HP lt2510
EV-DO/LTE Mobile Broadband Module)

 39.6 cm (15.6 in) FHD RGB UWVA display assembly with DreamColor

 39.6 cm (15.6 in) FHD AG RGB LED UWVA Dream Color

 39.6 cm (15.6 in) FHD AG RGB LED UWVA Dream Color with webcam

 Support privacy filter

 Ambient light sensor

Memory In models that use quad-core processors, four SODIMM customer-
accessible/upgradeable memory module slots supporting up to 32 GB of
RAM

 In models that use dual-core processors, two SODIMM customer-
accessible/upgradeable memory module slots supporting up to 16 GB of
RAM

 PC3-10600, 1333-MHz, DDR3

 Supports dual-channel memory

 Supports the following configurations:

● 2048 MB Total System Memory (2048 x 1)

● 4096 MB Total System Memory (4096 x 1)

● 4096 MB Total System Memory (2048 x 2)

● 8192 MB Total System Memory (8192 x 1)

● 8192 MB Total System Memory (4096 x 2)

● 8192 MB Total System Memory (2048 x 4) — only available with
quad-core processors

● 16384 MB Total System Memory (8192 x 2)

● 16384 MB Total System Memory (4096 x 4) — only available with
quad-core processors

● 32768 MB Total System Memory (8192 x 4) — only available with
quad-core processors

Primary location hard drive Customer-accessible

 Supports RAID 0/1

 Supports the following 7.0 mm, 9.5-mm, and 12.7 mm SATA hard drives
(6.35 cm (2.50 in) )

● 750 GB, 7200 rpm

● 500 GB, 7200 rpm

● 320 GB, 7200 rpm Self Encrypting Drive

● 320 GB, 7200 rpm

2 Chapter 1   Product description



Category Description

 Supports the following 6.35 cm (2.5 in) solid-state drives:

● 256 GB

● 128 GB

Upgrade bay Fixed (removal of 1 screw required)

 Customer-accessible

 Serial ATA

 Supports 500 GB, 7200 rpm drive

 Supports the following 12.7 mm tray load optical drives:

● DVD-ROM Drive

● DVD±RW and CD-RW SuperMulti Double Layer (DL) Drive

● Blu-ray Disc ROM DVD±RW SuperMulti DL Combo Drive

● Blu-ray Disc R/RE DVD±RW SuperMulti DL Drive

 Supports “No Drive” option

Microphone Integrated dual-array microphone

Audio HD Audio w/ SRS Premium Sound

 Stereo speakers

Webcam Integrated webcam (720p HD)

Modem 56K V.92 MDC data/fax modem

 Modem cable not included

 Supports “No Modem” option

Ethernet Intel 82579LM 10/100/1000 network interface card (NIC), with iAMT

 S3/S4/S5 wake on LAN

 NIC power down technology

 Ethernet cable not included

Wireless Integrated WLAN options by way of wireless module:

● Intel Centrino® Advanced-N 6205, 802.11a/b/g/n, 2 x 2

● Intel Centrino Ultimate-N 6300 802.11a/g/n, 3x3

● Atheros 802.11a/g/n, 3x3

 Three WLAN antennas built into display assembly

 Supports “no WLAN” option
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Category Description

 Integrated WWAN options by way of wireless module:

● HP un2430 EV-DO/HSPA Mobile Broadband Module supporting GPS
(After Market Option available)

● HP hs2340 HSPA+ Mobile Broadband Module supporting GPS (After
Market Option not available)

● HP lt2510 EV-DO/LTE Mobile Broadband Module (available only for
the 39.6 cm (15.6 in) FHD AG LED WVA display panel, part number
653275-001)—-After Market Option not available

 Two WWAN antennas built into display assembly

 Subscriber identity module (SIM) security (customer-accessible in battery
bay)

 Supports “no WWAN” option

 Integrated personal area network (PAN) options by way of
Bluetooth® module:

 HP Integrated Module with Bluetooth 2.1 Wireless Technology

 Supports “no WPAN” option

External media card One ExpressCard/54 slot

 Integrated Media Card Reader supports Secure Digital Card (SD), SD
High Capacity (SDHC), SD eXtended-Capacity (SDXC), MultiMediaCard
(MMC), and MMCplus (MMC+) formats

Ports Audio-in (stereo microphone)

 Audio-out (stereo headphone)

 DisplayPort (1.1a for models having NVIDIA graphics cards, 1.2 for
modules having AMD graphics cards)

 RJ-11 (modem)

 RJ-45 (Ethernet, includes link and activity lights)

 USB 3.0 (2)

 USB 2.0 (2)

 eSATA/USB 2.0 combo

 VGA (Dsub 15-pin)

 1394a

 3-pin AC power

 Docking connector

 Microphone Input (mono)

 Multi-pin AC

Docking HP Docking Station

 HP Advanced Docking Station

Keyboard/pointing devices Full-size keyboard with separate numeric keypad and TouchPad scroll
zone
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Category Description

 Backlit full-size keyboard with separate numeric keypad and TouchPad
scroll zone (select models only)

 Dual point (pointing stick and TouchPad) with 3 pointing stick buttons, 3
TouchPad buttons, and scroll zone

 Spill-resistant design, DuraKey coating

 Chemically strengthened glass cover on TouchPad

 Taps and gestures enabled by default: 2-finger scrolling, 2-finger zoom
(pinch)

 Four launch buttons (QuickWeb/browser, wireless on/off, calculator, and
mute volume)

Power requirements AC adapter with localized cable plug support (3-wire plug with ground pin,
supports 3-pin DC connector):

● 200W SLIM Smart AC Adapter

● 150W SLIM Smart AC Adapter

● 120W SLIM Smart AC Adapter

 8-cell 2.8 Ah (83 Wh) Li-ion battery

 8-cell 2.8 Ah (75 Wh) Li-ion battery (Long-life)

 Support for 9-cell 73 Wh polymer HP ST09 Extended Life Battery (does
not support HP Fast Charge)

 Support for 9-cell 100 Wh cylindrical HP BB09 Ultra-Capacity Extended
Life Battery (does not support HP Fast Charge)

 HP Fast Charge Technology

Security Integrated fingerprint reader

 Full volume encryption

 Integrated smart card reader

 Security cable slot

 Trusted Platform Module (TPM) V.1.2

 Preboot authentication (password, smart card)

Operating system Preinstalled operating systems:

 Windows 7 Professional 64

 Windows 7 Professional 32

 Windows 7 Home Premium 64

 Windows Vista Home Basic 32

 FreeDOS

 Microsoft® Office preinstalled with operating system:

 Windows 7 Professional 32 with Microsoft® Office 2010 Starter

 Windows 7 Professional 64 with Microsoft Office 2010 Starter
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Category Description

 Web download:

 SRDVD Red Hat Enterprise Linux (RHEL)

 SRDVD SuSE Linux Enterprise (SLED)

Restore Media:

 Windows 7 Professional 64

 Windows 7 Professional 32

 Windows 7 Home Premium 64

 DRDVD Windows 7

 Windows Vista Home Basic 32 (available to service only)

 Windows XP Professional 64 (available to service only)

 DRDVD Windows Vista (available to service only)

 Web-only support:

 Windows XP Professional 32

 Windows XP Professional 64

 Windows Vista Business 32

 Windows Vista Business 64

 Windows Vista Enterprise 32

 Windows Vista Enterprise 64

 Windows 7 Enterprise 32

 Windows 7 Enterprise 64

 Windows 7 Ultimate 32

 Windows 7 Ultimate 64

 Certified:

 Microsoft WHQL

 SuSE Linux

 Novell

Serviceability End-user replaceable parts:

 AC adapter

 Battery (system)

 Hard drive

 Memory module

 Optical drive

 Mini-PCI components (WLAN, WWAN, SIM)
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2 External component identification

Top

TouchPad

Component Description

(1)  Left pointing stick button Functions like the left button on an external mouse.

(2)  Center pointing stick button Functions like the center button on an external mouse.

(3)  Pointing stick Moves the pointer and selects or activates items on the
screen.

(4)  Right pointing stick button Functions like the right button on an external mouse.

(5)  Right TouchPad button Functions like the right button on an external mouse.

(6)  Center TouchPad button Functions like the center button on an external mouse.

(7)  Left TouchPad button Functions like the left button on an external mouse.

(8)  TouchPad Moves the pointer and selects or activates items on the
screen.

(9)  TouchPad on/off button Turns the TouchPad on and off.
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Lights

Component Description

(1)  TouchPad on/off light ● Off: The TouchPad is on.

● Amber: The TouchPad is off.

(2)  Caps lock light On: Caps lock is on.

(3) Power light ● On: The computer is on.

● Blinking: The computer is in the Sleep state.

● Off: The computer is off or in Hibernation.

(4)  Num lock light On: Num lock is on.

NOTE: When the num lock light is on, the numeric
functions on the integrated numeric keypad are available.

(5) Wireless light ● White: An integrated wireless device, such as a
wireless local area network (WLAN) device and/or a
Bluetooth® device, is on.

● Amber: All wireless devices are off.

(6) Mute light ● Amber: Computer sound is off.

● White: Computer sound is on.

(7) QuickWeb light ● On: The computer is on.

● Off: The computer is off or in Hibernation.

NOTE: For more information, refer to “HP QuickWeb” in
this guide and to the HP QuickWeb software Help.

(8) Calculator light ● On: The Windows® calculator function is on.

● Blinking: When the calculator button is pressed, the
light blinks 4 times, and then the Windows calculator
opens.
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Buttons and fingerprint reader

Component Description

(1)  TouchPad on/off button Turns the TouchPad on and off.

(2) Power button ● When the computer is off, press the button to turn on
the computer.

● When the computer is on, press the button briefly to
initiate Sleep.

● When the computer is in the Sleep state, press the
button briefly to exit Sleep.

● When the computer is in Hibernation, press the button
briefly to exit Hibernation.

If the computer has stopped responding and Windows®
shutdown procedures are ineffective, press and hold the
power button for at least 5 seconds to turn off the computer.

To learn more about your power settings:

● Windows 7—Select Start > Control Panel > System
and Security > Power Options.

● Windows Vista—Select Start > Control Panel >
System and Maintenance > Power Options

● Or refer to the HP Notebook Reference Guide.

(3) Wireless button Turns the wireless feature on or off but does not establish a
wireless connection.

(4) Volume mute button Mutes and restores speaker sound.
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Component Description

(5) QuickWeb button ● When the computer is off or in Hibernation, press the
button to open HP QuickWeb.

● When the computer is in Microsoft Windows, press the
button to open the default Web browser.

● When the computer is in HP QuickWeb, press the
button to open the default Web browser.

NOTE: For more information, refer to “HP QuickWeb” in
this guide and to the HP QuickWeb software Help. If your
computer does not have HP QuickWeb software, the button
does not perform any action or function.

(6) Calculator button Opens the Windows calculator function.

(7)  Fingerprint reader Allows a fingerprint logon to Windows, instead of a
password logon.
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Keys

Component Description

(1)  esc key Displays system information when pressed in combination
with the fn key.

(2)  Function keys Execute frequently used system functions when pressed in
combination with the fn key.

(3)  fn key Executes frequently used system functions when pressed
in combination with a function key, or the esc key.

(4) Windows logo key Displays the Windows Start menu.

(5) Windows applications key Displays a shortcut menu for items beneath the pointer.

(6)  Integrated numeric keypad When the keypad has been enabled, the keys can be used
like an external numeric keypad.

(7)  num lk key Enables/disables the integrated numeric keypad when
pressed.
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Front

Component Description

(1) Wireless light ● White: An integrated wireless device, such as a wireless
local area network (WLAN) device and/or a Bluetooth®
device, is on.

● Amber: All wireless devices are off.

(2) Power light ● On: The computer is on.

● Blinking: The computer is in the Sleep state.

● Off: The computer is off or in Hibernation.

(3) Battery light ● Amber: A battery is charging.

● White: A battery is close to full charge capacity.

● Blinking amber: A battery that is the only available power
source has reached a low battery level. When the battery
reaches a critical battery level, the battery light begins
blinking rapidly.

● Off: If the computer is plugged into an external power
source, the light turns off when all batteries in the computer
are fully charged. If the computer is not plugged into an
external power source, the light stays off until the battery
reaches a low battery level.

(4) Drive light ● Blinking white: The hard drive or optical drive is being
accessed.

● Amber: HP 3D DriveGuard has temporarily parked the hard
drive.

(5) Display release latch Opens the computer.

(6) Media Card Reader Supports the following digital card formats:

● MultiMediaCard

● MultiMediaCardplus (MMC+)

● Secure Digital (SD) Card

● Secure Digital HC (SDHC) Card

● Secure Digital XC (SDXC) Card

(7) Speakers (2) Produce sound.

NOTE: To use the SRS Premium Sound software, select Start
> All Programs > SRS Premium Sound.
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Right

Component Description

(1) Audio-out (headphone) jack Produces sound when connected to optional powered
stereo speakers, headphones, ear buds, a headset, or
television audio.

WARNING! To reduce the risk of personal injury, adjust
the volume before putting on headphones, earbuds, or a
headset. For additional safety information, refer to the
Regulatory, Safety and Environmental Notices.

NOTE: When a device is connected to the headphone
jack, the computer speakers are disabled.

(2) Audio-in (microphone) jack Connects an optional computer headset microphone,
stereo array microphone, or monaural microphone.

(3) USB 3.0 ports (2) (select models only) Connect optional USB devices.

(4) External monitor port Connects an external VGA monitor or projector.

(5)  Smart card reader Supports optional smart cards.

(6)  Upgrade bay (Optical drive shown) Reads and writes (select models only) to an optical disc.

NOTE: The upgrade bay can hold either a hard drive, an
optical drive, or support a weight saver option.

(7)  Optical drive eject button Ejects the optical drive.
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Left

Component Description

(1) Security cable slot Attaches an optional security cable to the computer.

NOTE: The security cable is designed to act as a
deterrent, but it may not prevent the computer from being
mishandled or stolen.

(2) RJ-45 (network) jack Connects a network cable.

(3)  Vents (2) Enables airflow to cool internal components.

NOTE: The computer fan starts up automatically to cool
internal components and prevent overheating. It is normal
for the internal fan to cycle on and off during routine
operation.

(4) DisplayPort Connects an optional digital display device, such as a high-
performance monitor or projector.

(5) eSATA/USB 2.0 combo port Connects a high-performance eSATA component, such as
an eSATA external hard drive, or connects an optional USB
device.

(6) USB 2.0 port Connects an optional USB device.

(7) USB charging port Connects an optional USB device.

(8) 1394 port Connects an optional IEEE 1394 or 1394a device, such as
a camcorder.

(9) ExpressCard slot Supports optional ExpressCards.
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Display

Component Description

(1) Internal display switch Turns off the display or initiates Sleep if the display is closed
while the power is on.

NOTE: The display switch is not visible from the outside of the
computer.

(2) WLAN antennas (3)* Send and receive wireless signals to communicate with wireless
local area networks (WLAN).

(3) WWAN antennas (2)* Send and receive wireless signals to communicate with wireless
wide-area networks (WWAN).

(4) Internal microphones (2) Record sound.

(5) Webcam light (select models only) On: The webcam is in use.

(6) Webcam (select models only) Records video and captures still photographs.

To use the webcam, select Start > All Programs > HP >
HP Webcam.

(7) Ambient light sensor Automatically adjusts the display brightness based on the
lighting conditions in your environment.

*The antennas are not visible from the outside of the computer. For optimal transmission, keep the areas immediately
around the antennas free from obstructions. To see wireless regulatory notices, refer to the section of the Regulatory, Safety
and Environmental Notices that applies to your country or region. These notices are located in Help and Support.

Top 15



Rear

Component Description

(1) RJ-11 (modem) jack (select models only) Connects a modem cable.

(2) Power connector Connects an AC adapter.
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Bottom

Component Description

(1)  Battery bay Holds the battery.

(2) SIM slot Supports a wireless subscriber identity module (SIM). The
SIM slot is located inside the battery bay.

(3) Battery release latch Releases the battery from the battery bay.

(4)  Accessory battery connector Connects an optional accessory battery.

(5)  Docking connector Connects an optional docking device.

(6) Bottom cover release latch Releases the bottom cover from the computer.

(7)  Vents (4) Enable airflow to cool internal components.

NOTE: The computer fan starts up automatically to cool
internal components and prevent overheating. It is normal
for the internal fan to cycle on and off during routine
operation.
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Component Description

(8) Bluetooth compartment Contains a Bluetooth device (select models only).

(9) Wireless and memory module
compartments, and hard drive bay

Contains the hard drive, the wireless LAN module slot,
and the memory module slot.

CAUTION: To prevent an unresponsive system, replace
the wireless module only with a wireless module
authorized for use in the computer by the governmental
agency that regulates wireless devices in your country or
region. If you replace the module and then receive a
warning message, remove the module to restore
computer functionality, and then contact technical support
through Help and Support.
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3 Illustrated parts catalog

Service tag
When ordering parts or requesting information, provide the computer serial number and model
description provided on the service tag.

● Product name (1). This is the product name affixed to the front of the computer.

● Serial number (2). This alphanumeric identifier is unique to each product.

● Product part number (3). This identifier provides specific information about the product's
hardware components. The part number helps a service technician to determine what
components and parts are needed.

● Warranty (4). This number describes the duration (in years) of the warranty period for the
computer.
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Item Description Spare part number

(1) 39.6-cm (15.6 in) FHD RGB UWVA LCD display assembly with DreamColor 

 For use in computer models without webcams 653277-001

 For use in computer models with webcams 653278-001

(2) Keyboard with pointing stick (includes pointing stick and pointing stick cable)

 For use in Belgium

Backlit keyboard, for use in Belgium

652682-A41

652683-A41

 For use in Brazil 652682-201

 For use in Bulgaria

Backlit keyboard, for use in Bulgaria

652682-261

652683-261

 For use in the Czech Republic and Slovakia

Backlit keyboard, for use in the Czech Republic and Slovakia

652682-A81

652683-A81

 For use in Denmark

Backlit keyboard, for use in Denmark

652682-081

652683-081

 For use in France

Backlit keyboard, for use in France

652682-051

652683-051

 For use in French Canada

Backlit keyboard, for use in French Canada

652682-121

652683-121

 For use in Germany

Backlit keyboard, for use in Germany

652682-041

652683-041

 For use in Greece

Backlit keyboard, for use in Greece

652682-DJ1

652683-DJ1

 For use in Hungary

Backlit keyboard, for use in Hungary

652682-211

652683-211

 For use in Iceland

Backlit keyboard, for use in Iceland

652682-DD1

652683-DD1

 For use in Israel

Backlit keyboard, for use in Israel

652682-BB1

652683-BB1

 For use in Italy

Backlit keyboard, for use in Italy

652682-061

652683-061

 For use in Japan 652682-291

 For use in Latin America

Backlit keyboard, for use in Latin America

652682-161

652683-161

 For international use

Backlit keyboard, for international use

652682-B31

652683-B31
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Item Description Spare part number

 For use in Norway

Backlit keyboard, for use in Norway

652682-091

652683-091

 For use in Portugal

Backlit keyboard, for use in Portugal

652682-131

652683-131

 For use in Russia

Backlit keyboard, for use in Russia

652682-251

652683-251

 For use in Saudi Arabia

Backlit keyboard, for use in Saudi Arabia

652682-171

652683-171

 For use in Slovenia

Backlit keyboard, for use in Slovenia

652682-BA1

652683-BA1

 For use in South Korea

Backlit keyboard, for use in South Korea

652682-AD1

652683-AD1

 For use in Spain

Backlit keyboard, for use in Spain

652682-071

652683-071

 For use in Sweden and Finland

Backlit keyboard, for use in Sweden and Finland

652682-B71

652683-B71

 For use in Switzerland

Backlit keyboard, for use in Switzerland

652682-BG1

652683-BG1

 For use in Taiwan

Backlit keyboard, for use in Taiwan

652682-AB1

652683-AB1

 For use in Thailand

Backlit keyboard, for use in Thailand

652682-281

652683-281

 For use in Turkey

Backlit keyboard, for use in Turkey

652682-141

652683-141

 For use in the United Kingdom

Backlit keyboard, for use in the United Kingdom

652682-031

652683-031

 For use in the United States

Backlit keyboard, for use in the United States

652682-001

652683-001

(3) Top cover (includes TouchPad button and bracket) 652652-001

(4) Function button board 652665-001

(5) RTC battery 652650-001

(6) Bluetooth module (does not include Bluetooth module cable)

NOTE: The Bluetooth module spare part kit does not include a Bluetooth module cable.
The Bluetooth module cable is included in the Cable Kit, spare part number 652662-001.
For information about Cable Kit contents, see Cable Kit on page 30.

537921-001
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(7) Power button board 652654-001

(8) Fingerprint reader board bracket (included with the fingerprint reader board, spare part
number 652681-001)

 

(9) Northbridge chip heat plate (includes replacement thermal material) 652685-001

(10) Fingerprint reader board 652681-001

(11) Modem module (56k v.92 MDC data/fax modem)

NOTE: The modem module spare part kit does not include a modem module cable. The
modem module cable is included in the Cable Kit, spare part number 652662-001. For
information about Cable Kit contents, see Cable Kit on page 30.

628824-001

(12) TouchPad button board (included with top cover, spare part number)  

(13) RJ-11 (modem) jack (included in the Cable Kit, spare part number 652662-001. For
information about Cable Kit contents, see Cable Kit on page 30.)

 

(14) Secondary memory modules  

 8-GB 634091-001

 4-GB 621569-001

 2-GB 621565-001

(15) Speakers 652669-001

(16) Graphics card (includes replacement thermal material)

 NVIDIA Quadro 1000M graphics card 652673-001

 NVIDIA Quadro 2000M graphics card 652674-001

 AMD FirePro M5950 graphics card 652676-001

(17) Processor  

 Intel® Core™ i7 processors  

 i7-2860QM, 2.50 GHz (Turbo up to 3.60 GHz), quad-core processor, 8 MB L3 Cache, 8
threads, 45 W

666175-002

 i7-2820QM, 2.30 GHz (Turbo up to 3.40 GHz), quad-core processor, 8 MB L3 Cache, 8
threads, 45 W

657414-001

 i7-2760QM, 2.40 GHz (Turbo up to 3.50 GHz), quad-core processor, 6 MB L3 Cache, 8
threads, 45 W

666174-002

 i7-2720QM, 2.20 GHz (Turbo up to 3.30 GHz), quad-core processor, 6 MB L3 Cache, 8
threads, 45 W

657413-001

 i7-2670QM, 2.20 GHz (Turbo up to 3.10 GHz), quad-core processor, 6 MB L3 Cache, 8
threads, 45 W

665116-002

 i7-2630QM, 2.00 GHz (Turbo up to 2.90 GHz), quad-core processor, 6 MB L3 Cache, 8
threads, 45 W (not configurable with iAMT)

657412-001

 i7-2640M, 2.80 GHz (Turbo up to 3.40), dual-core processor, 3 MB L3 cache, 4 threads, 35
W

666173-002

 i7-2620M, 2.70 GHz (Turbo up to 3.40), dual-core processor, 4 MB L3 cache, 4 threads, 35
W

657411-001

 Intel Core i5 processors  
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 i5-2540M, 2.60 GHz (Turbo up to 3.30), dual-core processor, 3 MB L3 cache, 4 threads, 35
W

657410-001

 i5-2520M, 2.50 GHz (Turbo up to 3.20), dual-core processor, 3 MB L3 cache, 4 threads, 35
W

657409-001

(18) System board (includes replacement thermal material and VGA support bracket)  

 For use with dual-core processors in all countries except China and Ukraine 652637-001

 (Alcor chip upgrade) For use with dual-core processors in all countries except China and
Ukraine

684318-001

 For use with quad-core processors in all countries except China and Ukraine 652638-001

 (Alcor chip upgrade) For use with quad-core processors in all countries except China and
Ukraine

684319-001

 For use with dual-core processors in China and Ukraine only 656213-002

 (Alcor chip upgrade) For use with dual-core processors in China and Ukraine only 684320-001

 For use with quad-core processors in China and Ukraine only 656214-002

 (Alcor chip upgrade) For use with quad-core processors in China and Ukraine only 684321-001

(19) Video card fan/heat sink assembly  

 For use in computers with AMD FirePro M5950 and NVIDIA Quadro 1000M graphics cards 652675-001

 For use in computers with AMD FirePro M5950 for eSTAR 670940-001

 For use in computers with NVIDIA Quadro 2000M graphics cards 652677-001

(20) Battery latch (includes latch, knob, and spring)

NOTE: The battery latch is included with the base enclosure, spare part number
652649-001.

 

(21) Processor heat sink

NOTE: The processor heat sink is included with the video card fan/heat sink assembly,
spare part numbers 652675-001 and 652677-001.

 

 For use with AMD FirePro M5950 and NVIDIA Quadro 1000M graphics cards 652675-001

 For use with NVIDIA Quadro 2000M graphics cards 652677-001

(22) Service access cover latch

NOTE: The service access cover latch is included with the base enclosure, spare part
number 652649-001.

 

(23) Security lock

NOTE: The security lock is included with the base enclosure assembly, spare part
number 652649-001.

 

(24) Audio/USB 3.0 board 652668-001

(25) ExpressCard assembly  

 For use in models without the Alcor chip upgrade 652680-001

 For use in models with the Alcor chip upgrade 684793-001

(26) VGA port 652656-001
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(27) Secure Digital (SD) card/USB 2.0 assembly board 652670-001

(28) Power connector (included in the Cable Kit, spare part number 652662-001. For
information about Cable Kit contents, see Cable Kit on page 30.)

 

(29) RJ-45 (network) jack (included in the Cable Kit, spare part number 652662-001. For
information about Cable Kit contents, see Cable Kit on page 30.

 

(30) Smart card reader (includes door and cable) 652672-001

(31) Base enclosure 652649-001

(32) Smart card reader door (included with the smart card reader, spare part number
652672-001.)

 

(33) Primary memory modules (PC3-10600, 1333-MHz, DDR3)

 8 GB 634091-001

 4 GB 621569-001

 2 GB 621565-001

(34) Optical drive (includes bracket, bezel, and screws)

 DVD-ROM Drive 653019-001

 DVD±RW and CD-RW SuperMulti DL Combo Drive 653020-001

 Blu-ray Disc ROM DVD±RW SuperMulti DL Combo Drive 653021-001

 Blu-ray Disc R/RE DVD±RW SuperMulti DL Drive 653022-001

 Upgrade bay bezel (not illustrated) 660578-001

(35) WWAN module  

 HP hs2340 HSPA+ Mobile Broadband Module 632155-001

 HP un2430 EV-DO/HSPA Mobile Broadband Module 634400-001

 HP lt2510 EV-DO/LTE Mobile Broadband Module, requires Long Term Evolution (LTE)
display panel, part number 653273-001

634513-001

(36) Hard drive  

 750 GB, 7200 rpm 633252-001

 500 GB, 7200 rpm 634926-001

 320 GB, 7200 rpm, Self Encrypting 626978-001

 320 GB, 7200 rpm, 2.5-in 641672-001

 320 GB, 7200 rpm, 7-mm 641674-001

 Solid-state drive  

 256 GB solid-state drive 653435-001

 256 GB solid-state drive, SATA III 681121-001

 256 GB solid-state drive, Self-Encrypting Drive (SED) 684564-001

 128 GB solid-state drive 653434-001

 128 GB solid-state drive, SATA III 681120-001

Computer major components 25



Item Description Spare part number

 Hard drive upgrade bay (not illustrated) 655547-001

(37) WLAN module

 Intel Centrino Advanced N 6205, 2x2 a/b/g/n WiFi Adapter 631954-001

 Intel Centrino Ultimate-N 6300 802.11 3x3 a/g/n WiFi Adapter 572511-001

 Atheros 802.11 3x3 a/g/n WiFI Adapter 630435-001

(38) Battery  

 8-cell Li-ion 83-Wh battery 632427-001

 8-cell Li-ion 75-Wh battery 632425-001

 9-cell Li-ion 73-Wh extended life battery 634089-001

 9-cell Li-ion 100-Wh ultra-capacity extended life battery 634087-001

(39) Service access cover (with feet) 652648-001

 Cable Kit (not illustrated). For information about Cable Kit contents, see Cable Kit
on page 30.

652662-001
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Display components

Item Description Spare part number

(1) Display bezel  

 For use on computer models with a webcam 652639-001

 For use on computer models without a webcam 652640-001

(2) 39.6-cm (15.6 in) display panel  

 HD+ WVA display panel 653271-001

 FHD WVA display panel for use only with LTE module 653275-001

 FHD WVA display panel 653273-001

(3) Display hinges (includes left and right hinges) 652646-001

(4) Display cable kit 652641-001

(5) WLAN antennas and cables (included in the Cable Kit, spare part number 652662-001.
For information about Cable Kit contents, see Cable Kit on page 30.)
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(6) WWAN antennas and cables (included in the Cable Kit, spare part number 652662-001.
For information about Cable Kit contents, see Cable Kit on page 30.)

 

(7) Cable routing tray (included with the Raw Panel Support Kit, 657408-001)  

(8) Webcam module 652659-001

(9) Ambient light sensor 652689-001

 Raw Panel Support Kit 657408-001

(10) Display enclosure  

 WLAN antennas and cables  

 WWAN antennas and cables  

 Cable routing tray  

(11) Display Hinge Cover Kit  

 For use on computer models without DreamColor displays 652657-001

 For use on computer models with DreamColor displays 652658-001

(12) Logo nameplate (with light; for use on the back cover of the LCD; not illustrated)

NOTE: This part is not shown in the illustration.

652666-001
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Plastics Kit

Item Description Spare part number

 Plastics Kit: 652664-001

 Plastics Kit (for use in models with the Alcor chip upgrade) 684794-001

(1) Battery cover

(2) SD Card blank

(3) Optical drive weight saver

(4) Display latch button

(5) RJ-11 jack cover

(6) ExpressCard blank

(7) Inverter cover (2 are included—one for models with DreamColor and one for models
without DreamColor)
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Cable Kit

Item Description Spare part number

 Cable Kit: 652662-001

(1) WWAN antenna  

(2) WLAN antenna  

(3) Bluetooth module cable  

(4) RJ11 connector cable  

(5) RJ45 connector cable  

(6) Power connector cable  

(7) TouchPad cable
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Mass storage devices

Item Description Spare part number

(1) Hard drive bracket (included in the Hard Drive Hardware Kit, spare part number
644694-001)

 

(2) Hard drive

 750 GB, 7200 rpm 633252-001

 500 GB, 7200 rpm 634926-001

 320 GB, 7200 rpm, Self Encrypting 626978-001

 320 GB, 7200 rpm, 2.5-in 641672-001

 320 GB, 7200 rpm, 7-mm 641674-001

 Solid-state drive (not shown)

 256 GB solid-state drive (SSD) 653435-001

 256 GB solid-state drive, SATA III 681121-001

 256 GB solid-state drive, Self-Encrypting Drive (SED) 684564-001

 128 GB solid-state drive 653434-001

 128 GB solid-state drive, SATA III 681120-001

 Hard drive upgrade bay (not illustrated) 655547-001

(3) Optical drive

 DVD±RW and CD-RW SuperMulti DL Combo Drive 653020-001

 Blu-ray Disc R/RE DVD±RW SuperMulti DL Drive 653022-001

 DVD-ROM Drive 653019-001
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 Blu-ray Disc ROM DVD±RW SuperMulti DL Combo Drive 653021-001

(4) Optical drive bracket 652688-001

 Upgrade bay bezel (not illustrated) 660578-001

Miscellaneous parts

Description Spare part number

AC adapters

200-W AC adapter 645154-001

120-W AC adapter 645156-001

150-W AC adapter 646212-001

Power cords:

For use in Argentina 490371-D01

For use in Australia 490371-011

For use in Brazil 490371-202

For use in Bulgaria 490371-021

For use in Denmark 490371-081

For use in India 490371-D61

For use in Israel 490371-BB1

For use in Italy 490371-061

For use in Japan 490371-291

For use in the People's Republic of China 490371-AA1

For use in South Africa 490371-AR1

For use in South Korea 490371-AD1

For use in Switzerland 490371-111

For use in Taiwan 490371-AB1

For use in Thailand 490371-201

For use in the United Kingdom and Singapore 490371-031

For use in the United States 490371-001

Power cord for use in North America (3-prong) 491683-001

Power cord for use in Australia (3-prong) 491683-011

Power cord for use in Europe, the Middle East, and Africa (3-prong) 491683-021

Power cord for use in the United Kingdom and Singapore (3-prong) 491683-031

Power cord for use in Italy (3-prong) 491683-061
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Description Spare part number

Power cord for use in Denmark (3-prong) 491683-081

Power cord for use in Switzerland (3-prong) 491683-111

Power cord for use in Thailand (3-prong) 491683-201

Power cord for use in Brazil (3-prong)(3-prong) 491683-202

Power cord for use in Japan (3-prong) 491683-291

Power cord for use in the People's Republic of China (3-prong) 491683-AA1

Power cord for use in Taiwan (3-prong) 491683-AB1

Power cord for use in India (3-prong) 491683-D61

Power cord for use in Saudi Arabia (3-prong) 491683-171

Power cord for use in South Korea (3-prong) 491683-AD1

Power cord for use in South Africa (3-prong) 491683-AR1

Power cord for use in Israel (3-prong) 491683-BB1

Power cord for use in Argentina (3-prong) 491683-D01

Rubber Kit (includes rubber feet and rubber screw covers) 652663-001

Plastics Kit (for more information about the Plastics Kit, see Plastics Kit on page 29.) 652664-001

Plastics Kit (for use in models with the Alcor chip upgrade) 684794-001

Mouse  

Optical 390632-001

Travel, USB 434594-001

Notebook combination lock 591699-001

Case, professional slim top load 592923-001
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HP keyed cable lock 626729-001

Screw Kit

● Phillips M2.0×5.0 captive screw

● Black Phillips M2.5×12.0 captive screw

● Silver Phillips M2.5×12.0 captive screw

● Phillips M2.0×7.0 captive screw

● Phillips M2.0×4.0 screw

● Phillips M3.0×3.0 screw

● Phillips M2.5×5.0 screw

● Phillips M2.5×3.0 screw

● Phillips M2.0×3.0 screw

● Black Phillips M2.5×6.0 screw

● Black Phillips M2.0×5.0 screw

● HM2.5×6.0 hex screw lock

● Torx 8M2.5×7.0 screw

● Torx 8M2.5×8.0 screw

● Torx 8M2.0×8.0 screw

● Torx 8M2.5×6.0 screw

652661-001
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Sequential part number listing

Spare part
number

Description

390632-001 Mouse, optical

434594-001 Mouse, travel, USB

490371-001 Power cord for use in North America (3-pin)

490371-011 Power cord for use in Australia (3-pin)

490371-021 Power cord for use in Europe, the Middle East, and Africa (3-pin)

490371-031 Power cord for use in the United Kingdom and Singapore (3-pin)

490371-061 Power cord for use in Italy (3-pin)

490371-081 Power cord for use in Denmark (3-pin)

490371-111 Power cord for use in Switzerland (3-pin)

490371-201 Power cord for use in Thailand (3-pin)

490371-202 Power cord for use in Brazil (3-pin)

490371-291 Power cord for use in Japan (3-pin)

490371-AA1 Power cord for use in the People's Republic of China (3-pin)

490371-AB1 Power cord for use in Taiwan (3-pin)

490371-AD1 Power cord for use in South Korea (3-pin)

490371-AR1 Power cord for use in South Africa (3-pin)

490371-BB1 Power cord for use in Israel (3-pin)

490371-D01 Power cord for use in Argentina (3-pin)

490371-D61 Power cord for use in India (3-pin)

491683-001 Power cord for use in North America (3-prong)

491683-011 Power cord for use in Australia (3-prong)

491683-021 Power cord for use in Europe, the Middle East, and Africa (3-prong)

491683-031 Power cord for use in the United Kingdom and Singapore (3-prong)

491683-061 Power cord for use in Italy (3-prong)

491683-081 Power cord for use in Denmark (3-prong)

491683-111 Power cord for use in Switzerland (3-prong)

491683-171 Power cord for use in Saudi Arabia (3-prong)

491683-201 Power cord for use in Thailand (3-prong)

491683-202 Power cord for use in Brazil (3-prong)(3-prong)

491683-291 Power cord for use in Japan (3-prong)

491683-AA1 Power cord for use in the People's Republic of China (3-prong)

491683-AB1 Power cord for use in Taiwan (3-prong)
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Spare part
number

Description

491683-AD1 Power cord for use in South Korea (3-prong)

491683-AR1 Power cord for use in South Africa (3-prong)

491683-BB1 Power cord for use in Israel (3-prong)

491683-D01 Power cord for use in Argentina (3-prong)

491683-D61 Power cord for use in India (3-prong)

537921-001 Bluetooth module

572511-001 Intel Centrino Ultimate-N 6300 802.11 3x3 a/g/n WiFi Adapter

591699-001 Notebook combination lock

592923-001 Case, professional slim top load

621565-001 2-GB memory module (PC3-10600, 1333-MHz, DDR3)

621569-001 4-GB memory module (PC3-10600, 1333-MHz, DDR3)

626729-001 HP keyed cable lock

626978-001 320-GB, 7200-rpm hard drive, Self Encrypting (includes hard drive bracket and screws)

628824-001 56k v.92 MDC data/fax modem module 

NOTE: The modem module spare part kit does not include a modem module cable. The modem module
cable is included in the Cable Kit, spare part number 652662-001. For information about Cable Kit contents,
see Cable Kit on page 30.

630435-001 Atheros 802.11 3x3 a/g/n WiFI Adapter

631954-001 Intel Centrino Advanced N 6205, 2x2 a/b/g/n WiFi Adapter

632155-001 HP hs2340 HSPA+ Mobile Broadband Module

632425-001 8-cell, 2.8-Ah (75-Wh) Li-ion battery

632427-001 8-cell, 2.8-Ah (83-Wh) Li-ion battery

633252-001 750 GB, 7200 rpm hard drive (includes hard drive bracket and screws)

634087-001 9-cell, 3.0-Ah (100-Wh) Li-ion ultra-capacity extended life battery

634089-001 9-cell, 2.8-Ah (73-Wh) Li-ion extended life battery

634091-001 8 GB memory module (PC3-10600, 1333 MHz, DDR3)

634400-001 HP un2430 EV-DO/HSPA Mobile Broadband Module

634513-001 HP lt2510 EV-DO/LTE Mobile Broadband Module (requires Long Term Evolution panel)

634926-001 500 GB, 7200 rpm hard drive (includes hard drive bracket and screws)

641672-001 320 GB, 7200 rpm hard drive, 2.5-in (includes hard drive bracket and screws)

641674-001 320 GB, 7200 rpm hard drive, 7 mm (includes hard drive bracket and screws)

644694-001 Hard Drive Hardware Kit

645154-001 200-W AC adapter

645156-001 120-W AC adapter
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Spare part
number

Description

646212-001 150-W AC adapter

652637-001 System board for use with dual-core processors in all countries and regions except Russia and the People's
Republic of China (does not include Alcor chip upgrade; includes replacement thermal material and VGA
support bracket)

652638-001 System board for use with quad-core processors in all countries and regions except Russia and the
People's Republic of China (does not include Alcor chip upgrade; includes replacement thermal material
and VGA support bracket)

652639-001 Display bezel for use on computer models with a webcam

652640-001 Display bezel for use on computer models without a webcam

652641-001 Display cable for use on computer models without DreamColor displays (includes microphone and webcam
connector)

652646-001 Display hinges (includes left and right hinges)

652647-001 Display latch with hook

652648-001 Service access cover

652649-001 Base enclosure

652650-001 RTC battery

652652-001 Top cover for use on computer models that include a fingerprint reader (includes TouchPad button and
bracket)

652654-001 Power button board

652656-001 VGA port

652657-001 Display hinge covers (for use on computer models without DreamColor displays)

652658-001 Display hinge covers (for use on computer models with DreamColor displays)

652659-001 Webcam module

652660-001 Microphone board

652661-001 Screw Kit 

652662-001 Cable Kit (for information about Cable Kit contents, see Cable Kit on page 30.

652663-001 Rubber Kit (includes rubber feet and rubber screw covers)

652664-001 Plastics Kit (for information about Plastics Kit contents, see Plastics Kit on page 29.

652665-001 Function button board

652666-001 Logo nameplate with light; for use on the back cover of the LCD

652668-001 Audio/USB 3.0 board (select models only)

652669-001 Speakers 

652670-001 Secure Digital (SD) card/USB 2.0 assembly board

652672-001 Smart card reader (includes door and cable) 

652673-001 NVIDIA Quadro 1000M graphics card (includes replacement thermal material)

652674-001 NVIDIA Quadro 2000M graphics card (includes replacement thermal material)
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652675-001 Heat sink with fan (for use in computers with AMD FirePro M5950 and NVIDIA Quadro 1000M graphics
cards) 

652676-001 AMD FirePro M5950 graphics card (includes replacement thermal material)

652677-001 Heat sink with fan (for use in computers with NVIDIA Quadro 2000M graphics cards)

652680-001 ExpressCard assembly board for use in models without the Alcor chip upgrade

652681-001 Fingerprint reader board (includes fingerprint reader board cable)

652682-001 Keyboard with pointing stick for use in the United States (includes keyboard and pointing stick cables)

652682-031 Keyboard with pointing stick for use in the United Kingdom (includes keyboard and pointing stick cables)

652682-041 Keyboard with pointing stick for use in Germany (includes keyboard and pointing stick cables)

652682-051 Keyboard with pointing stick for use in France (includes keyboard and pointing stick cables)

652682-061 Keyboard with pointing stick for use in Italy (includes keyboard and pointing stick cables)

652682-071 Keyboard with pointing stick for use in Spain (includes keyboard and pointing stick cables)

652682-081 Keyboard with pointing stick for use in Denmark (includes keyboard and pointing stick cables)

652682-091 Keyboard with pointing stick for use in Norway (includes keyboard and pointing stick cables)

652682-121 Keyboard with pointing stick for use in French Canada (includes keyboard and pointing stick cables)

652682-131 Keyboard with pointing stick for use in Portugal (includes keyboard and pointing stick cables)

652682-141 Keyboard with pointing stick for use in Turkey (includes keyboard and pointing stick cables)

652682-161 Keyboard with pointing stick for use in Latin America (includes keyboard and pointing stick cables)

652682-171 Keyboard with pointing stick for use in Saudi Arabia (includes keyboard and pointing stick cables)

652682-201 Keyboard with pointing stick for use in Brazil (includes keyboard and pointing stick cables)

652682-211 Keyboard with pointing stick for use in Hungary (includes keyboard and pointing stick cables)

652682-251 Keyboard with pointing stick for use in Russia (includes keyboard and pointing stick cables)

652682-261 Keyboard with pointing stick for use in Bulgaria (includes keyboard and pointing stick cables)

652682-281 Keyboard with pointing stick for use in Thailand (includes keyboard and pointing stick cables)

652682-291 Keyboard with pointing stick for use in Japan (includes keyboard and pointing stick cables)

652682-A41 Keyboard with pointing stick for use in Belgium (includes keyboard and pointing stick cables)

652682-A81 Keyboard with pointing stick for use in the Czech Republic and Slovakia (includes keyboard and pointing
stick cables)

652682-AB1 Keyboard with pointing stick for use in Taiwan (includes keyboard and pointing stick cables)

652682-AD1 Keyboard with pointing stick for use in South Korea (includes keyboard and pointing stick cables)

652682-B31 Keyboard with pointing stick for international use (includes keyboard and pointing stick cables)

652682-B71 Keyboard with pointing stick for use in Sweden and Finland (includes keyboard and pointing stick cables)

652682-BA1 Keyboard with pointing stick for use in Slovenia (includes keyboard and pointing stick cables)

652682-BB1 Keyboard with pointing stick for use in Israel (includes keyboard and pointing stick cables)
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652682-BG1 Keyboard with pointing stick for use in Switzerland (includes keyboard and pointing stick cables)

652682-D61 Keyboard with pointing stick for use in India (includes keyboard and pointing stick cables)

652682-DD1 Keyboard with pointing stick for use in Iceland (includes keyboard and pointing stick cables)

652682-DJ1 Keyboard with pointing stick for use in Greece (includes keyboard and pointing stick cables)

652682-DW1 Keyboard with pointing stick for use in the Africa - French/Arabic (includes keyboard and pointing stick
cables)

652683-001 Backlit keyboard with pointing stick for use in the United States (includes keyboard and pointing stick
cables)

652683-031 Backlit keyboard with pointing stick for use in the United Kingdom (includes keyboard and pointing stick
cables)

652683-041 Backlit keyboard with pointing stick for use in Germany (includes keyboard and pointing stick cables)

652683-051 Backlit keyboard with pointing stick for use in France (includes keyboard and pointing stick cables)

652683-061 Backlit keyboard with pointing stick for use in Italy (includes keyboard and pointing stick cables)

652683-071 Backlit keyboard with pointing stick for use in Spain (includes keyboard and pointing stick cables)

652683-081 Backlit keyboard with pointing stick for use in Denmark (includes keyboard and pointing stick cables)

652683-091 Backlit keyboard with pointing stick for use in Norway (includes keyboard and pointing stick cables)

652683-121 Backlit keyboard with pointing stick for use in French Canada (includes keyboard and pointing stick cables)

652683-131 Backlit keyboard with pointing stick for use in Portugal (includes keyboard and pointing stick cables)

652683-141 Backlit keyboard with pointing stick for use in Turkey (includes keyboard and pointing stick cables)

652683-161 Backlit keyboard with pointing stick for use in Latin America (includes keyboard and pointing stick cables)

652683-171 Backlit keyboard with pointing stick for use in Saudi Arabia (includes keyboard and pointing stick cables)

652683-211 Backlit keyboard with pointing stick for use in Hungary (includes keyboard and pointing stick cables)

652683-251 Backlit keyboard with pointing stick for use in Russia (includes keyboard and pointing stick cables)

652683-261 Backlit keyboard with pointing stick for use in Bulgaria (includes keyboard and pointing stick cables)

652683-281 Backlit keyboard with pointing stick for use in Thailand (includes keyboard and pointing stick cables)

652683-A41 Backlit keyboard with pointing stick for use in Belgium (includes keyboard and pointing stick cables)

652683-A81 Backlit keyboard with pointing stick for use in Czech Republic and Slovakia (includes keyboard and pointing
stick cables)

652683-AB1 Backlit keyboard with pointing stick for use in Taiwan (includes keyboard and pointing stick cables)

652683-AD1 Backlit keyboard with pointing stick for use in South Korea (includes keyboard and pointing stick cables)

652683-B31 Backlit keyboard with pointing stick for international use (includes keyboard and pointing stick cables)

652683-B71 Backlit keyboard with pointing stick for use in Sweden and Finland (includes keyboard and pointing stick
cables)

652683-BA1 Backlit keyboard with pointing stick for use in Slovenia (includes keyboard and pointing stick cables)

652683-BB1 Backlit keyboard with pointing stick for use in Israel (includes keyboard and pointing stick cables)

652683-BG1 Backlit keyboard with pointing stick for use in Switzerland (includes keyboard and pointing stick cables)
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Spare part
number

Description

652683-D61 Backlit keyboard with pointing stick for use in India (includes keyboard and pointing stick cables)

652683-DD1 Backlit keyboard with pointing stick for use in Iceland (includes keyboard and pointing stick cables)

652683-DJ1 Backlit keyboard with pointing stick for use in Greece (includes keyboard and pointing stick cables)

652683-DW1 Backlit keyboard with pointing stick for use in Africa - French/Arabic (includes keyboard and pointing stick
cables)

652684-001 Pointing stick cover

652685-001 PCH thermal material

652687-001 Smart card bracket

652688-001 Optical drive bracket

652689-001 Ambient light sensor board (includes cable)

653019-001 DVD-ROM drive

653020-001 DVD±RW and CD-RW SuperMulti DL Combo Drive

653021-001 Blu-ray Disc ROM DVD±RW SuperMulti DL Combo Drive

653022-001 Blu-ray Disc R/RE DVD±RW SuperMulti DL Drive 

653271-001 39.6-cm (15.6 in) HD+ WVA display panel

653273-001 39.6-cm (15.6 in) FHD WVA display panel

653275-001 39.6-cm (15.6 in) FHD WVA LTE display panel

653277-001 39.6-cm (15.6 in) FHD RGB UWVA display assembly with DreamColor for computer models without
webcams

653278-001 39.6-cm (15.6 in) FHD RGB UWVA display assembly with DreamColor for computer models with webcams

653434-001 128 GB solid-state drive (SSD) (includes hard drive bracket and screws)

653435-001 256 GB solid-state drive (SSD) (includes hard drive bracket and screws)

655547-001 Hard drive upgrade bay

656213-002 System board with dual-core processors for use only in the People's Republic of China and Ukraine (does
not include Alcor chip upgrade; includes replacement thermal material and VGA support bracket)

656214-002 System board with quad-core processors for use only in the People's Republic of China and Ukraine (does
not include Alcor chip upgrade; includes replacement thermal material and VGA support bracket)

657408-001 Raw Panel Support Kit (includes a display enclosure with display cable, WLAN antennas and cables,
WWAN antennas, and cables, and cable routing tray) 

657409-001 i5-2520M, 2.50 GHz (Turbo up to 3.20) processor 3 MB L3 cache, 4 threads

657410-001 i5-2540M, 2.60 GHz (Turbo up to 3.30) processor 3 MB L3 cache, 4 threads

657411-001 i7-2620M, 2.70 GHz (Turbo up to 3.40) processor 4 MB L3 cache, 4 threads

657412-001 i7-2630QM, 2.00 GHz (Turbo up to 2.90 GHz), processor 6 MB L3 Cache, 8 threads, 45 W (not
configurable with iAMT)

657413-001 i7-2720QM, 2.20 GHz (Turbo up to 3.30 GHz), processor 6 MB L3 Cache, 8 threads, 45W

657414-001 i7-2820QM, 2.30 GHz (Turbo up to 3.40 GHz), processor 8 MB L3 Cache, 8 threads, 45W
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Spare part
number

Description

660578-001 Upgrade bay bezel

665116-002 i7-2670QM, 2.20 GHz (Turbo up to 3.10 GHz), processor 6 MB L3 Cache, 8 threads, 45 W (not
configurable with iAMT)

666173-002 i7-2640M, 2.80 GHz (Turbo up to 3.40 GHz), processor 3 MB L3 Cache, 8 threads, 45 W

666174-002 i7-2760QM, 2.40 GHz (Turbo up to 3.30 GHz), processor 6 MB L3 Cache, 8 threads, 45 W

666175-002 i7-2860QM, 2.50 GHz (Turbo up to 3.60 GHz), processor 6 MB L3 Cache, 8 threads, 45 W

670940-001 Video card fan/heat sink assembly for use in computers with AMD FirePro M5950 for eSTAR

681120-001 128 GB solid-state drive (SSD), SATA III (includes hard drive bracket and screws)

681121-001 256 GB solid-state drive (SSD), SATA III (includes hard drive bracket and screws)

684318-001 (Alcor chip upgrade) System board with dual-core processors for use in all countries and regions except for
the People's Republic of China and Ukraine (includes replacement thermal material and VGA support
bracket)

684319-001 (Alcor chip upgrade) System board with quad-core processors for use only in all countries and regions
except for the People's Republic of China and Ukraine (includes replacement thermal material and VGA
support bracket)

684320-001 (Alcor chip upgrade) System board with dual-core processors for use only in the People's Republic of China
and Ukraine (includes replacement thermal material and VGA support bracket)

684321-001 (Alcor chip upgrade) System board with quad-core processors for use only in the People's Republic of
China and Ukraine (includes replacement thermal material and VGA support bracket)

684564-001 256 GB solid-state drive (SSD), Self-Encrypting Drive (SED) (includes hard drive bracket and screws)

684793-001 ExpressCard assembly board for use in models with the Alcor chip upgrade

684794-001 Plastics Kit for use in models with the Alcor chip upgrade
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4 Removal and replacement procedures

Preliminary replacement requirements

Tools required

You will need the following tools to complete the removal and replacement procedures:

● Flat-bladed screwdriver

● Phillips P0 and P1 screwdrivers

● Torx 9 screwdriver

Service considerations

The following sections include some of the considerations that you must keep in mind during
disassembly and assembly procedures.

NOTE: As you remove each subassembly from the computer, place the subassembly (and all
accompanying screws) away from the work area to prevent damage.

Plastic parts

CAUTION: Using excessive force during disassembly and reassembly can damage plastic parts.
Use care when handling the plastic parts. Apply pressure only at the points designated in the
maintenance instructions.
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Cables and connectors

CAUTION: When servicing the computer, be sure that cables are placed in their proper locations
during the reassembly process. Improper cable placement can damage the computer.

Cables must be handled with extreme care to avoid damage. Apply only the tension required to
unseat or seat the cables during removal and insertion. Handle cables by the connector whenever
possible. In all cases, avoid bending, twisting, or tearing cables. Be sure that cables are routed in
such a way that they cannot be caught or snagged by parts being removed or replaced. Handle flex
cables with extreme care; these cables tear easily.

Drive handling

CAUTION: Drives are fragile components that must be handled with care. To prevent damage to
the computer, damage to a drive, or loss of information, observe these precautions:

Before removing or inserting a hard drive, shut down the computer. If you are unsure whether the
computer is off or in Hibernation, turn the computer on, and then shut it down through the operating
system.

Before handling a drive, be sure that you are discharged of static electricity. While handling a drive,
avoid touching the connector.

Before removing a diskette drive or optical drive, be sure that a diskette or disc is not in the drive and
be sure that the optical drive tray is closed.

Handle drives on surfaces covered with at least 2.5 cm (one inch) of shock-proof foam.

Avoid dropping drives from any height onto any surface.

After removing a hard drive, an optical drive, or a diskette drive, place it in a static-proof bag.

Avoid exposing a hard drive to products that have magnetic fields, such as monitors or speakers.

Avoid exposing a drive to temperature extremes or liquids.

If a drive must be mailed, place the drive in a bubble pack mailer or other suitable form of protective
packaging and label the package “FRAGILE.”
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Grounding guidelines

Electrostatic discharge damage

Electronic components are sensitive to electrostatic discharge (ESD). Circuitry design and structure
determine the degree of sensitivity. Networks built into many integrated circuits provide some
protection, but in many cases, ESD contains enough power to alter device parameters or melt
silicon junctions.

A discharge of static electricity from a finger or other conductor can destroy static-sensitive devices or
microcircuitry. Even if the spark is neither felt nor heard, damage may have occurred.

An electronic device exposed to ESD may not be affected at all and can work perfectly throughout a
normal cycle. Or the device may function normally for a while, and then degrade in the internal layers,
reducing its life expectancy.

CAUTION: To prevent damage to the computer when you are removing or installing internal
components, observe these precautions:

Keep components in their electrostatic-safe containers until you are ready to install them.

Use nonmagnetic tools.

Before touching an electronic component, discharge static electricity by using the guidelines
described in this section.

Avoid touching pins, leads, and circuitry. Handle electronic components as little as possible.

If you remove a component, place it in an electrostatic-safe container.

The following table shows how humidity affects the electrostatic voltage levels generated by different
activities.

CAUTION: A product can be degraded by as little as 700 V.

Typical electrostatic voltage levels

 Relative humidity

Event 10% 40% 55%

Walking across carpet 35,000 V 15,000 V 7,500 V

Walking across vinyl floor 12,000 V 5,000 V 3,000 V

Motions of bench worker 6,000 V 800 V 400 V

Removing DIPS from plastic tube 2,000 V 700 V 400 V

Removing DIPS from vinyl tray 11,500 V 4,000 V 2,000 V

Removing DIPS from Styrofoam 14,500 V 5,000 V 3,500 V

Removing bubble pack from PCB 26,500 V 20,000 V 7,000 V

Packing PCBs in foam-lined box 21,000 V 11,000 V 5,000 V
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Packaging and transporting guidelines

Follow these grounding guidelines when packaging and transporting equipment:

● To avoid hand contact, transport products in static-safe tubes, bags, or boxes.

● Protect ESD-sensitive parts and assemblies with conductive or approved containers or
packaging.

● Keep ESD-sensitive parts in their containers until the parts arrive at static-free workstations.

● Place items on a grounded surface before removing items from their containers.

● Always be properly grounded when touching a component or assembly.

● Store reusable ESD-sensitive parts from assemblies in protective packaging or nonconductive
foam.

● Use transporters and conveyors made of antistatic belts and roller bushings. Be sure that
mechanized equipment used for moving materials is wired to ground and that proper materials
are selected to avoid static charging. When grounding is not possible, use an ionizer to dissipate
electric charges.

Workstation guidelines

Follow these grounding workstation guidelines:

● Cover the workstation with approved static-shielding material.

● Use a wrist strap connected to a properly grounded work surface and use properly grounded
tools and equipment.

● Use conductive field service tools, such as cutters, screwdrivers, and vacuums.

● When fixtures must directly contact dissipative surfaces, use fixtures made only of static-safe
materials.

● Keep the work area free of nonconductive materials, such as ordinary plastic assembly aids and
Styrofoam.

● Handle ESD-sensitive components, parts, and assemblies by the case or PCM laminate. Handle
these items only at static-free workstations.

● Avoid contact with pins, leads, or circuitry.

● Turn off power and input signals before inserting or removing connectors or test equipment.
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Equipment guidelines

Grounding equipment must include either a wrist strap or a foot strap at a grounded workstation.

● When seated, wear a wrist strap connected to a grounded system. Wrist straps are flexible
straps with a minimum of one megohm ±10% resistance in the ground cords. To provide proper
ground, wear a strap snugly against the skin at all times. On grounded mats with banana-plug
connectors, use alligator clips to connect a wrist strap.

● When standing, use foot straps and a grounded floor mat. Foot straps (heel, toe, or boot straps)
can be used at standing workstations and are compatible with most types of shoes or boots. On
conductive floors or dissipative floor mats, use foot straps on both feet with a minimum of one
megohm resistance between the operator and ground. To be effective, the conductive strips
must be worn in contact with the skin.

The following grounding equipment is recommended to prevent electrostatic damage:

● Antistatic tape

● Antistatic smocks, aprons, and sleeve protectors

● Conductive bins and other assembly or soldering aids

● Nonconductive foam

● Conductive tabletop workstations with ground cords of one megohm resistance

● Static-dissipative tables or floor mats with hard ties to the ground

● Field service kits

● Static awareness labels

● Material-handling packages

● Nonconductive plastic bags, tubes, or boxes

● Metal tote boxes

● Electrostatic voltage levels and protective materials

The following table lists the shielding protection provided by antistatic bags and floor mats.

Material Use Voltage protection level

Antistatic plastic Bags 1,500 V

Carbon-loaded plastic Floor mats 7,500 V

Metallized laminate Floor mats 5,000 V

46 Chapter 4   Removal and replacement procedures



Component replacement procedures
This chapter provides removal and replacement procedures.

There are as many as 95 screws and screw locks, in 15 different sizes, that must be removed,
replaced, or loosened when servicing the computer. Make special note of each screw and screw lock
size and location during removal and replacement.

Service tag

When ordering parts or requesting information, provide the computer serial number and model
description provided on the service tag.

● Product name (1). This is the product name affixed to the front of the computer.

● Serial number (2). This alphanumeric identifier is unique to each product.

● Product part number (3). This identifier provides specific information about the product's
hardware components. The part number helps a service technician to determine what
components and parts are needed.

● Warranty (4). This number describes the duration (in years) of the warranty period for the
computer.
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Battery

Description Spare part number

8-cell, 83-Wh Li-ion battery 632427-001

8-cell, 75-Wh Li-ion battery 632425-001

9-cell, 73-Wh Li-ion extended life battery 634089-001

9-cell, 100-Wh Li-ion ultra-capacity extended life battery 634087-001

Before disassembling the computer, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn
the computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet,
and then unplugging the AC adapter from the computer.

Remove the battery:

1. Turn the computer upside-down on a flat surface, with the battery bay toward you.

2. Slide the battery release latch (1) to release the battery.

3. Rotate the battery (2) forward, and then remove it from the computer (3) from the computer.

Install the battery by inserting it into the battery bay until you hear a click.
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SIM

NOTE: If there is a SIM inserted in the SIM slot, it must be removed before disassembling the
computer. Be sure that the SIM is reinserted in the SIM slot after reassembling the computer.

Before removing the SIM, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn
the computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet,
and then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 48).

Remove the SIM:

1. Inside the battery bay, press in on the SIM (1). (The module is partially ejected from the SIM
slot.)

2. Remove the SIM (2) from the SIM slot.

Reverse this procedure to install the SIM.
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Service access cover

Description Spare part number

Service access cover 652648-001

Before removing the service access cover, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn
the computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet
and then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 48).

Remove the service access cover:

1. Position the computer upside down, with the front of the computer toward you.

2. Slide the service access cover release latch to the left (1).

3. Slide the service access cover toward you (2).

4. Remove the service access cover (3).
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Expansion memory modules

NOTE: Expansion memory slots are located in a compartment on the bottom of the computer.

A computer having a system board with spare part number 652637-001, 656213-002, 684318-001, or
684320-001 has two memory module slots, which are called primary memory slots in this MSG.
When you add or replace memory modules, slot 1 must be populated before slot 2 is populated.

A computer having a system board with spare part number 652638-001, 656214-002, 684319-001, or
684321-001 has four memory slots. On these computers, in both the expansion memory slots (on the
bottom of the computer) and the primary memory slots (under the keyboard), slot 1 must be
populated before slot 2 is populated.

Description Spare part number

2 GB (PC3-10600, 1333 MHz, DDR3) 621565-001

4 GB (PC3-10600, 1333 MHz, DDR3) 621569-001

8 GB (PC3-10600, 1333 MHz, DDR3) 634091-001

Before removing a memory module, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn
the computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet,
and then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 48).

5. Remove the service access cover (see Service access cover on page 50).

Remove the memory module:

1. Position the computer upside-down, with the front toward you.

2. Spread the retaining tabs (1) on each side of the memory module slot to release the memory
module. (The edge of the module opposite the slot rises away from the computer.)

Component replacement procedures 51



3. Remove the memory module (2) by pulling the module away from the slot at an angle.

NOTE: Memory modules are designed with a notch (3) to prevent incorrect insertion into the
memory module slot.

Reverse this procedure to install a primary expansion memory module.
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RTC battery

Description Spare part number

RTC battery 652650-001

Before removing the RTC battery, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn
the computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet,
and then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 48).

5. Remove the service access cover (see Service access cover on page 50).

Remove the RTC battery:

1. Position the computer upside-down, with the front toward you.

2. Disconnect the RTC battery cable (1) from the system board.

3. Gently pull the battery (2) from the double-sided tape that secures it to the system board and
remove it from the computer.

Reverse this procedure to install the RTC battery.
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WLAN module

CAUTION: The WLAN module and the WWAN module are not interchangeable.

Description Spare part number

Atheros 802.11 3x3 a/g/n WiFI Adapter 630435-001

Intel Centrino Ultimate-N 6300 802.11 3x3 a/g/n WiFi Adapter 572511-001

Intel Centrino Advanced N 6205, 2x2 a/b/g/n WiFi Adapter 631954-001

Before removing the WLAN module, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn
the computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet,
and then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 48).

5. Remove the service access cover (see Service access cover on page 50).

Remove the WLAN module:

1. Position the computer upside-down, with the front toward you.

2. Disconnect the WLAN antenna cables (1), (2), and (3) from the terminals on the WLAN module.

NOTE: The black WLAN antenna cable is connected to the WLAN module “Main” terminal.
The white WLAN antenna cable is connected to the WLAN module “Aux” terminal. If the
computer is equipped with an 802.11a/b/g/n WLAN module, the yellow WLAN antenna cable is
connected to the middle terminal on the WLAN module.

3. Remove the two Phillips M2.5×3.0 screws (4) that secure the WLAN module to the computer.
(The edge of the module opposite the slot rises away from the computer.)
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4. Remove the WLAN module (5) by pulling the module away from the slot at an angle.

NOTE: WLAN modules are designed with a notch (6) to prevent incorrect insertion.

Reverse this procedure to install the WLAN module.
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WWAN module

CAUTION: The WWAN module and the WLAN module are not interchangeable.

Description Spare part number

HP hs2340 HSPA+ Mobile Broadband Module 632155-001

HP un2430 EV-DO/HSPA Mobile Broadband Module 634400-001

HP lt2510 EV-DO/LTE Mobile Broadband Module (requires Long Term Evolution panel) 634513-001

Before removing the WWAN module, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn
the computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet,
and then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 48).

5. Remove the service access cover (see Service access cover on page 50).

Remove the WWAN module:

1. Position the computer right-side up with front toward you.

2. Disconnect the WWAN antenna cables (1) and (2) from the terminals on the WWAN module.

NOTE: The red WWAN antenna cable is connected to the WWAN module “Main” terminal. The
blue WWAN antenna cable is connected to the WWAN module “Aux” terminal.

3. Remove the two Phillips M2.5×3.0 screws (3) that secure the WWAN module to the computer.
(The edge of the module opposite the slot rises away from the computer.)
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4. Remove the WWAN module (4) by pulling the module away from the slot at an angle.

NOTE: WWAN modules are designed with a notch (5) to prevent incorrect insertion.

Reverse this procedure to install the WWAN module.
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Bluetooth module

NOTE: The Bluetooth module spare part kit does not include a Bluetooth module cable. The
Bluetooth module cable is included in the Cable Kit, spare part number 652662-001. For information
about Cable Kit contents, see Cable Kit on page 30.

Description Spare part number

Bluetooth module 537921-001

Before removing the Bluetooth module, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn
the computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet,
and then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 48).

5. Remove the service access cover (see Service access cover on page 50).

Remove the Bluetooth module:

1. Position the computer upside-down, with the front toward you.

2. Remove the tape from the top of the Bluetooth module (1).

3. Remove the tape from the Bluetooth cable (2).

4. Disconnect the Bluetooth cable (3) from the system board.

5. Disconnect the Bluetooth module cable (4) from the Bluetooth module.
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6. Remove the Bluetooth module.

Reverse this procedure to install the Bluetooth module.
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Hard drive

Description Spare part number

750 GB, 7200 rpm hard drive 633252-001

500 GB, 7200 rpm hard drive 634926-001

320 GB, 7200 rpm, Self Encrypting hard drive 626978-001

320 GB, 7200 rpm hard drive, 2.5-in 641672-001

320 GB, 7200 rpm hard drive, 7-mm 641674-001

256 GB solid-state drive (SSD) 653435-001

256 GB solid-state drive, SATA III 681121-001

256 GB solid-state drive, Self-Encrypting Drive (SED) 684564-001

128 GB solid-state drive (SSD) 653434-001

128 GB solid-state drive, SATA III 681120-001

Hard drive upgrade bay 655547-001

Hard Drive Hardware Kit (includes hard drive bracket and screws) 644694-001

Before disassembling the computer, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn
the computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet,
and then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 48).

5. Remove the service access cover (see Service access cover on page 50).

Remove the hard drive:

1. Position the computer upside-down, with the front toward you.

2. Remove the tape from the top of the smart card reader door (1).
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3. Loosen the two Phillips M2.0×5.0 captive screws (2) that secure the smart card reader door to
the computer.

4. Open the smart card reader door until it rests on its hinges (1).

5. Remove three Phillips M2.50×6.0 spring-loaded screws (2) that secure the hard drive to the
computer.

6. Grasp the tab on the hard drive, pull the hard drive to the left (3), and remove the hard drive (4)
from the hard drive bay.
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7. If it is necessary to replace the hard drive bracket, remove the four Phillips M3.0×3.0 hard drive
bracket screws (1) from the sides of the hard drive.

8. Lift the bracket (2) straight up to remove it from the hard drive.

Reverse this procedure to reassemble and install the hard drive.
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Smart card reader

Description Spare part number

Smart card reader (includes door and cable) 652672-001

Before removing the smart card reader, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn
the computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet,
and then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 48).

5. Remove the service access cover (see Service access cover on page 50).

6. Remove the hard drive (see Hard drive on page 60).

Remove the smart card reader:

1. If you need to replace the smart card reader door, close the door (1).

2. Open the zero insertion force (ZIF) connector for the smart card reader cable (2) and then
disconnect the cable from the system board (3).
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3. Reopen the door (1), and then lift the smart card reader door straight up from the computer (2).

4. If it is necessary to replace the smart card reader, remove the two Phillips M2.0×3.0 screws (1)
that secure the smart card reader to the smart card reader door.

5. Slide the smart card reader out of the smart card reader door (2) while allowing the cable to slide
out of the door guide (3).

Reverse this procedure to reassemble and install the smart card reader.
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Optical drive

NOTE: All optical drive spare part kits include an optical drive bezel.

Description Spare part number

DVD-ROM Drive 653019-001

DVD±RW and CD-RW SuperMulti DL Combo Drive 653020-001

Blu-ray Disc ROM DVD±RW SuperMulti DL Combo Drive 653021-001

Blu-ray Disc R/RE DVD±RW SuperMulti DL Drive 653022-001

Upgrade bay bezel (not illustrated) 660578-001

Before removing the optical drive, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn
the computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet,
and then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 48).

5. Remove the service access cover (see Service access cover on page 50).

6. Remove the hard drive (see Hard drive on page 60).

Remove the optical drive:

1. Position the computer upside-down with the front side toward you.

2. Remove the Phillips M2.5×12.0 locking screw (1) that secures the optical drive to the computer.

3. Insert a small tool (2) into the drive release opening and press the optical drive tab to the left.

4. Remove the optical drive (3) from the computer.
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5. If it is necessary to replace the optical drive bracket, position the optical drive with the rear
toward you.

6. Remove the three Phillips M2.0×3.0 screws (1) that secure the optical drive bracket to the optical
drive.

7. Remove the optical drive bracket (2).

Reverse this procedure to install an optical drive.

66 Chapter 4   Removal and replacement procedures



Keyboard

NOTE: For spare part numbers, see Computer major components on page 20.

Before removing the keyboard, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn
the computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet,
and then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 48).

5. Remove the service access cover (see Service access cover on page 50).

6. Remove the optical drive (see Optical drive on page 65).

Remove the keyboard:

1. Turn the computer upside-down, with the rear toward you.

2. Loosen the three Phillips captive spring-loaded screws (1) that secure the keyboard to the
computer.

3. Open the computer and turn it on its side.

4. Insert a finger into the finger hole (1), and press on the keyboard until it disengages from the
base enclosure.

NOTE: The center of the keyboard is the release point. If the keyboard does not easily
disengage, press on the keyboard through the opening in the optical drive area (2).

5. Turn the opened computer right-side up, with the front toward you.
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6. Lift the rear edge of the keyboard and then rotate the keyboard (3) forward until it rests upside-
down on top of the TouchPad.

7. Release the ZIF connector for the keyboard cable (1), and then disconnect the cable from the
system board (2).

8. Release the ZIF connector for the pointing stick cable (3) and then disconnect the cable from the
system board (4).

9. Remove the keyboard (5).
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Reverse this procedure to install the keyboard.

Primary memory module

NOTE: Primary memory is installed under the keyboard.

A computer having a system board with spare part number 652637-001, 656213-002, 684318-001, or
684320-001 has two memory slots (primary memory slots). When adding or replacing memory
modules, slot 1 must be populated before slot 2 is populated.

A computer having a system board with spare part number 652638-001, 656214-002, 684319-001, or
684321-001 has four memory slots (expansion memory slots) (on the bottom of the computer) and
the primary memory slots (under the keyboard). Slot 2 cannot be populated if slot 1 is not populated.

Description Spare part number

2 GB (PC3-10600, 1333 MHz, DDR3) 621565-001

4 GB (PC3-10600, 1333 MHz, DDR3) 621569-001

8 GB (PC3-10600, 1333 MHz, DDR3) 634091-001

Before removing a memory module, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn
the computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet,
and then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 48).

5. Remove the service access cover (see Service access cover on page 50).

6. Remove the following components:

a. Hard drive (see Hard drive on page 60)

b. Keyboard (see Keyboard on page 67)

Remove the memory module:

1. Spread the retaining tabs (1) on each side of the memory module slot to release the memory
module. (The edge of the module opposite the slot rises away from the computer.)
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2. Remove the memory module (2) by pulling the module away from the slot at an angle.

NOTE: Memory modules are designed with a notch (3) to prevent incorrect insertion into the
memory module slot.

Reverse this procedure to install a primary memory module.
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Top cover

The top covers include TouchPad button and bracket.

Description Spare part number

For use on computer models with a fingerprint reader 652652-001

Before removing the top cover, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn
the computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet,
and then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 48).

5. Remove the service access cover (see Service access cover on page 50).

6. Remove the following components:

a. Hard drive (see Hard drive on page 60)

b. Optical drive (see Optical drive on page 65)

c. Keyboard (see Keyboard on page 67)

Remove the top cover:

1. Turn the computer right-side up, with the front toward you.

2. Release the following ZIF connectors (1) and disconnect the corresponding cables (2) from the
system board:

● Power button ZIF connector

● TouchPad ZIF cable

● TouchPad buttons ZIF cable

● Fingerprint reader ZIF cable

● Application buttons ZIF cable
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3. Remove the following screws that secure the top cover to the base enclosure:

● Four Torx 9M2.5×4.0 screws in the battery bay (1)

● Three Torx 9M2.0×4.0 screws in the optical drive bay (2)

● Five Torx 9M2.5×6.0 screws from the front edge and middle of the computer (3)

● Three Phillips M2.5×3.0 screws from the hard drive bay (4)
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4. Pull up the back edge (1) of the top cover, and then lift the cover (2) away at an angle.

Reverse this procedure to install the top cover.
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Power button board

Description Spare part number

Power button board 652654-001

Before removing the power button board, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn
the computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet,
and then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 48).

5. Remove the service access cover (see Service access cover on page 50).

6. Remove the following components:

a. Hard drive (see Hard drive on page 60)

b. Optical drive (see Optical drive on page 65)

c. Keyboard (see Keyboard on page 67)

d. Top cover (see Top cover on page 71)

Remove the power button board:

1. Position the top cover upside-down, with the front toward you.

2. Remove the two pieces of tape from the top of the power button board (1).

3. Release the ZIF connector (2) for the power button board cable and then disconnect the cable
(3).
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4. Remove the two Torx 9M2.5×4.0 screws (4) that secure the power button board to the top cover
and then remove the power button board (5).

Reverse this procedure to install the power button board.
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Function button board

Description Spare part number

Function button board (includes cable) 652665-001

Before removing the function button board, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn
the computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet,
and then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 48).

5. Remove the service access cover (see Service access cover on page 50).

6. Remove the following components:

a. Hard drive (see Hard drive on page 60)

b. Optical drive (see Optical drive on page 65)

c. Keyboard (see Keyboard on page 67)

d. Top cover (see Top cover on page 71)

Remove the function button board:

1. Position the top cover upside-down, with the front toward you.

2. Remove the tape (1) from the top of the function button board.

3. Remove the two Torx 9M2.5×4.0 screws (2) that secure the function button board to the top
cover.

4. Lift the function button board (3) from the top cover.
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5. Disconnect the function button board cable (4) from the function button board.

Reverse this procedure to install the function button board.
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Fingerprint reader board

Description Spare part number

Fingerprint reader board (includes bracket) 652681-001

Before removing the fingerprint reader board, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn
the computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet,
and then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 48).

5. Remove the service access cover (see Service access cover on page 50).

6. Remove the following components:

a. Hard drive (see Hard drive on page 60)

b. Optical drive (see Optical drive on page 65)

c. Keyboard (see Keyboard on page 67)

d. Top cover (see Top cover on page 71)

Remove the fingerprint reader board:

1. Position the top cover upside-down, with the front toward you.

2. Remove the Phillips M2.0×3.0 screw (1) that secures the fingerprint reader board to the top
cover.

3. Remove the fingerprint reader board bracket (2) from the fingerprint reader board.
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4. Lift the fingerprint reader board (3) from the top cover.

Reverse this procedure to install the fingerprint reader board.
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TouchPad button board

Description Spare part number

TouchPad button board (included with top cover, spare part number 652652-001)  

Before removing the TouchPad button board, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn
the computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet,
and then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 48).

5. Remove the service access cover (see Service access cover on page 50).

6. Remove the following components:

a. Hard drive (see Hard drive on page 60)

b. Optical drive (see Optical drive on page 65)

c. Keyboard (see Keyboard on page 67)

d. Top cover (see Top cover on page 71)

Remove the TouchPad button board:

1. Position the top cover upside-down, with the front toward you.

2. Release the ZIF connector (1) for the TouchPad button board cable and then disconnect the
cable (2).

3. Remove the four Torx 9M2.5×4.0 screws (3) that secure the TouchPad button board to the top
cover.
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4. Lift the TouchPad button board (4) from the top cover.

Reverse this procedure to install the TouchPad button board.
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VGA port

Description Spare part number

VGA port 652656-001

Before removing the VGA port, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn
the computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet,
and then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 48).

5. Remove the service access cover (see Service access cover on page 50).

6. Remove the following components:

a. Hard drive (see Hard drive on page 60)

b. Optical drive (see Optical drive on page 65)

c. Keyboard (see Keyboard on page 67)

d. Top cover (see Top cover on page 71)

Remove the VGA port:

1. Position the computer right-side up with the front toward you.

2. Remove the Phillips M2.5×9.0 screw (1) that secures the VGA port to the base enclosure.

3. Remove the two Torx 9M2.5×3.0 screws (2) that secure the VGA port to the base enclosure.
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4. Lift and remove the port from the base enclosure (3).

Reverse this procedure to install the VGA port.
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Video card fan/heat sink assembly

Description Spare part number

Video card fan/heat sink assembly for use in computers with AMD FirePro M5950 and NVIDIA
Quadro 1000M graphics cards

652675-001

Video card fan/heat sink assembly for use in computers with AMD FirePro M5950 for eSTAR 670940-001

Video card fan/heat sink assembly for use in computers with NVIDIA Quadro 2000M graphics
cards

652677-001

Before removing the video card fan/heat sink assembly, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn
the computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet,
and then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 48).

5. Remove the service access cover (see Service access cover on page 50).

6. Remove the following components:

a. Hard drive (see Hard drive on page 60)

b. Optical drive (see Optical drive on page 65)

c. Keyboard (see Keyboard on page 67)

d. Top cover (see Top cover on page 71)

Remove the video card fan/heat sink assembly:

1. Position the computer right-side up, with the front toward you.

2. Disconnect the fan cable (1) from the system board.

3. Remove the three Torx 9M2.5×6.0 screws (2) that secure the fan to the base enclosure.

NOTE: The screw closest to the display may be hidden under display cables.

4. Loosen the four captive screws (3) that secure the video card heat sink to the base enclosure.
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5. Lift the video card fan/heat sink assembly from the base enclosure (4).

NOTE: The thermal material must be thoroughly cleaned from the surfaces of the heat sink (1), (2),
(3), and (4) and the system board (5), (6), (7), and (8), each time the heat sink is removed.
Replacement thermal material is included with all heat sink and system board spare part kits.

Reverse this procedure to install the video card fan/heat sink assembly.

NOTE: To properly ventilate the computer, allow at least a 7.6 cm (3 in) clearance on the left side of
the computer.

The computer uses an electric fan for ventilation. The fan is controlled by a temperature sensor and is
designed to turn on automatically when high temperature conditions exist. These conditions are
affected by high external temperatures, system power consumption, power management/battery
conservation configurations, battery fast charging, and software requirements. Exhaust air is
displaced through the ventilation grill located on the left side of the computer.
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Processor heat sink

All heat sink spare part kits include replacement thermal material.

Description Spare part number

NOTE: The processor heat sink is included with the video card fan/heat sink assembly.  

Video card fan/heat sink assembly for use in computers with AMD FirePro M5950 and NVIDIA
Quadro 1000M graphics cards

652675-001

Video card fan/heat sink assembly for use in computers with NVIDIA Quadro 2000M graphics
cards

652677-001

Before removing the processor heat sink, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn
the computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet,
and then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 48).

5. Remove the service access cover (see Service access cover on page 50).

6. Remove the following components:

a. Hard drive (see Hard drive on page 60)

b. Optical drive (see Optical drive on page 65)

c. Keyboard (see Keyboard on page 67)

d. Top cover (see Top cover on page 71)

e. Video card fan/heat sink assembly (see Video card fan/heat sink assembly on page 84)

Remove the processor heat sink:

1. Position the computer right-side up, with the front toward you.

2. Loosen the four captive screws (1) that secure the processor heat sink to the base enclosure.
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3. Remove the heat sink (2) from the computer.

NOTE: The thermal material must be thoroughly cleaned from the surfaces of the processor heat
sink components (1) and system board components (2) each time the processor heat sink is
removed. Thermal material is included with all heat sink and processor spare part kits.

Reverse this procedure to install the processor heat sink.
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Graphics card

NOTE: All graphics card spare part kits include replacement thermal material.

Description Spare part number

NVIDIA Quadro 1000M graphics card 652673-001

NVIDIA Quadro 2000M graphics card 652674-001

AMD FirePro M5950 graphics card 652676-001

Before removing the graphics card, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn
the computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet,
and then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 48).

5. Remove the service access cover (see Service access cover on page 50).

6. Remove the following components:

a. Hard drive (see Hard drive on page 60)

b. Optical drive (see Optical drive on page 65)

c. Keyboard (see Keyboard on page 67)

d. Top cover (see Top cover on page 71)

e. Video card fan/heat sink assembly (see Video card fan/heat sink assembly on page 84)

f. Processor heat sink (see Processor heat sink on page 86)

Remove the graphics card:

1. Position the computer right-side up, with the front toward you.

2. Remove the two Torx 9M2.5×6.0 screws (1) that secure the graphics card to the computer. (The
edge of the board opposite the graphics card slot rises away from the computer.)
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3. Remove the graphics card (2) by sliding it away from the slot at an angle.

NOTE: The thermal material must be thoroughly cleaned from the surfaces of the graphics card
components (1), (2), (3), and (4) and the system board components (5), (6), (7), and (8), each time
the graphics card is removed. Replacement thermal material is included with all graphics card and
system board spare part kits.

Reverse this procedure to install the graphics card.
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Processor

NOTE: All processor spare part kits include replacement thermal material.

Description Spare part number

Intel Core i7 processors, quad-core  

i7-2860QM, 2.50-GHz (Turbo up to 3.60) processor 8-MB L3 cache, 8 threads 666175-002

i7-2820QM, 2.30-GHz (Turbo up to 3.40) processor 8-MB L3 cache, 8 threads 657414-001

i7-2760QM, 2.40-GHz (Turbo up to 3.50) processor 6-MB L3 cache, 8 threads 666174-002

i7-2720QM, 2.20-GHz (Turbo up to 3.30) processor 6-MB L3 cache, 8 threads 657413-001

i7-2670QM, 2.20-GHz (Turbo up to 3.10) processor 6-MB L3 cache, 8 threads (not configurable
with iAMT)

665116-002

i7-2630QM, 2.00-GHz (Turbo up to 2.90) processor 6-MB L3 cache, 8 threads (not configurable
with iAMT)

657412-001

Intel Core i7 processor, dual-core  

i7-2640M, 2.80-GHz (Turbo up to 3.40) processor 3-MB L3 cache, 8 threads 666173-002

i7-2620M, 2.70-GHz (Turbo up to 3.40) processor 4-MB L3 cache, 4 threads 657411-001

Intel Core i5 processors, dual-core  

i5-2540M, 2.60-GHz (Turbo up to 3.30) processor 3-MB L3 cache, 4 threads 657410-001

i5-2520M, 2.50-GHz (Turbo up to 3.20) processor 3-MB L3 cache, 4 threads 657409-001

Before removing the processor, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn
the computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet,
and then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 48).

5. Remove the service access cover (see Service access cover on page 50).

6. Remove the following components:

a. Hard drive (see Hard drive on page 60)

b. Optical drive (see Optical drive on page 65)

c. Keyboard (see Keyboard on page 67)

d. Top cover (see Top cover on page 71)

e. Video card fan/heat sink assembly (see Video card fan/heat sink assembly on page 84)

f. Processor heat sink (see Processor heat sink on page 86)
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Remove the processor:

1. Position the computer right-side up, with the front toward you.

2. Use a flat-bladed screwdriver to turn the processor locking screw (1) one-half turn
counterclockwise until you hear a click.

3. Lift the processor (2) straight up and remove it.

NOTE: The gold triangle (3) on the processor must be aligned with the triangle embossed on
the processor slot when you install the processor.

Reverse this procedure to install the processor.
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Modem module

NOTE: The modem module spare part kit does not include a modem module cable. The modem
module cable is included in the Cable Kit, spare part number 652662-001. For information about
Cable Kit contents, see Cable Kit on page 30.

Description Spare part number

56k v.92 MDC data/fax modem module 628824-001

Before removing the modem module, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn
the computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet,
and then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 48).

5. Remove the service access cover (see Service access cover on page 50).

6. Remove the following components:

a. Hard drive (see Hard drive on page 60)

b. Optical drive (see Optical drive on page 65)

c. Keyboard (see Keyboard on page 67)

d. Top cover (see Top cover on page 71)

e. Video card fan/heat sink assembly (see Video card fan/heat sink assembly on page 84)

f. Processor heat sink (see Processor heat sink on page 86)

g. Processor (see Processor on page 90)

Remove the modem module:

1. Turn the computer right-side up, with the front toward you.

2. Remove the two Phillips M2.0×3.0 barrel screws (1) that secure the modem module to the
system board.

3. Disconnect the modem module (2) from the system board by lifting it straight up.
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4. Disconnect the modem module cable (3) from the system board.

Reverse this procedure to install the modem module.

Component replacement procedures 93



Audio/USB 3.0 board

Description Spare part number

Audio/USB 3.0 board (select models only) 652668-001

Before removing the audio/USB 3.0 board, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn
the computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet,
and then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 48).

5. Remove the service access cover (see Service access cover on page 50).

6. Remove the following components:

a. Hard drive (see Hard drive on page 60)

b. Optical drive (see Optical drive on page 65)

c. Keyboard (see Keyboard on page 67)

d. Top cover (see Top cover on page 71)

e. Video card fan/heat sink assembly (see Video card fan/heat sink assembly on page 84)

f. Processor heat sink (see Processor heat sink on page 86)

g. Processor (see Processor on page 90)

h. Modem module (see Modem module on page 92)

Remove the audio/USB 3.0 board:

1. Turn the computer right-side up, with the front toward you.

2. Remove the three Torx 9M2.5×4.0 screws (1) that secure the audio/USB 3.0 board to the
system board.
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3. Disconnect the audio/USB 3.0 board (2) from the system board by lifting it out at an angle.

Reverse this procedure to install the modem module.
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Speakers

Description Spare part number

Speaker 652669-001

Before removing the speakers, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn
the computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet,
and then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 48).

5. Remove the service access cover (see Service access cover on page 50).

6. Remove the following components:

a. Hard drive (see Hard drive on page 60)

b. Optical drive (see Optical drive on page 65)

c. Keyboard (see Keyboard on page 67)

d. Top cover (see Top cover on page 71)

e. Video card fan/heat sink assembly (see Video card fan/heat sink assembly on page 84)

f. Processor heat sink (see Processor heat sink on page 86)

g. Processor (see Processor on page 90)

h. Modem module (see Modem module on page 92)

i. Audio/USB 3.0 board (see Audio/USB 3.0 board on page 94)

Remove the speakers:

1. Position the computer right-side up, with the front toward you.

2. Remove the display latch:

a. Remove the spring (1) from the display latch lock.

b. Remove the three Phillips M2.0×2.0 screws (2) from the display latch lock.

c. Push down the button (3) in the front right corner of the display latch lock.
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d. Slide the display latch lock to the left and remove by pulling straight up from the base
enclosure (4).

3. Remove the display latch spring buttons:

a. In the lower right corner of the base enclosure, remove the two Torx 9M2.0×4.0 screws (1)
that secure the display latch spring button to the base enclosure.

b. Lift the right display latch spring button (2) straight up from the base enclosure.

4. Remove the tape (1) from the top of the speakers.

5. Disconnect the speaker cable (2) from the system board.
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6. Remove the four Torx 9M2.0×4.0 screws (3) that secure the speakers to the base enclosure.

7. Remove the speakers (4) from the base enclosure.

Reverse this procedure to install the speakers.
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Secure Digital (SD) card/USB 2.0 assembly

Description Spare part number

Secure Digital (SD) card/USB 2.0 assembly 652670-001

Before removing the Secure Digital (SD) card/USB 2.0 board, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn
the computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet,
and then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 48).

5. Remove the service access cover (see Service access cover on page 50).

6. Remove the following components:

a. Hard drive (see Hard drive on page 60)

b. Optical drive (see Optical drive on page 65)

c. Keyboard (see Keyboard on page 67)

d. Top cover (see Top cover on page 71)

e. Video card fan/heat sink assembly (see Video card fan/heat sink assembly on page 84)

f. Processor heat sink (see Processor heat sink on page 86)

g. Processor (see Processor on page 90)

h. Modem module (see Modem module on page 92)

i. Audio/USB 3.0 board (see Audio/USB 3.0 board on page 94)

j. Speakers (see Speakers on page 96)

Remove the Secure Digital (SD) card/USB 2.0 assembly:

1. Position the computer right-side up, with the front toward you.

2. Remove the SD slot protective insert (1).

3. Remove the three Torx 9M2.5×4.0 screws (2) that secure the assembly to the system board.
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4. Lift the assembly up (3) and remove the assembly from the base enclosure at a 45 degree angle
(4).

Reverse this procedure to install the Secure Digital (SD) card/USB 2.0 assembly.
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Northbridge chip heat plate

Description Spare part number

Northbridge chip heat plate 652685-001

Before removing the Northbridge chip heat plate, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn
the computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet,
and then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 48).

5. Remove the service access cover (see Service access cover on page 50).

6. Remove the following components:

a. Hard drive (see Hard drive on page 60)

b. Optical drive (see Optical drive on page 65)

c. Keyboard (see Keyboard on page 67)

d. Top cover (see Top cover on page 71)

Remove the Northbridge chip heat plate:

1. Position the computer right-side up, with the front toward you.

2. Remove the two Phillips M2.5×3.0 screws (1) that secure the Northbridge chip heat plate to the
system board.
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3. Remove the Northbridge chip heat plate from the system board (2).

Reverse this procedure to install the Northbridge chip heat plate.
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RJ-45 connector cable

NOTE: The RJ-45 connector cable is included in the Cable Kit, spare part number 652662-001.

Before removing the RJ-45 connector cable, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn
the computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet,
and then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 48).

5. Remove the service access cover (see Service access cover on page 50).

6. Remove the following components:

a. Hard drive (see Hard drive on page 60)

b. Optical drive (see Optical drive on page 65)

c. Keyboard (see Keyboard on page 67)

d. Top cover (see Top cover on page 71)

e. Video card fan/heat sink assembly (see Video card fan/heat sink assembly on page 84)

f. Processor heat sink (see Processor heat sink on page 86)

Remove the RJ-45 connector cable:

1. Position the computer right-side up, with the front toward you.

2. Remove the tape (1) from the top of the RJ-45 connector cable.

3. Remove the RJ-45 connector cable from the clips and routing channel (2) built into the base
enclosure.
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4. Remove the RJ-45 connector cable from the base enclosure (3).

Reverse this procedure to install the RJ-45 connector cable.
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Power connector cable

NOTE: The power connector cable is included in the Cable Kit, spare part number 652662-001.

Before removing the power connector cable, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn
the computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet,
and then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 48).

5. Remove the service access cover (see Service access cover on page 50).

6. Remove the following components:

a. Hard drive (see Hard drive on page 60)

b. Optical drive (see Optical drive on page 65)

c. Keyboard (see Keyboard on page 67)

d. Top cover (see Top cover on page 71)

e. Video card fan/heat sink assembly (see Video card fan/heat sink assembly on page 84)

f. Processor heat sink (see Processor heat sink on page 86)

Remove the power connector cable:

1. Position the computer right-side up, with the front toward you.

2. Remove the tape (1) from the top of the power connector cable.

3. Lift the power connector cable (2) up from the routing in the rear of the base enclosure.
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4. Remove the power connector cable from the enclosure (3).

Reverse this procedure to install the power connector cable.
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System board

NOTE: All system board spare part kits include replacement thermal material and VGA support
bracket.

NOTE: Models that support quad-core processors have four memory slots. Models that support
dual-core processors have two memory slots.

Description Spare part number

For use with dual-core processors 652637-001

(Alcor chip upgrade) For use with dual-core processors 684318-001

For use with quad-core processors 652638-001

(Alcor chip upgrade) For use with quad-core processors 684319-001

For use with dual-core processors in China and Ukraine 656213-002

(Alcor chip upgrade) For use with dual-core processors in China and Ukraine 684320-001

For use with quad-core processors in China and Ukraine 656214-002

(Alcor chip upgrade) For use with quad-core processors in China and Ukraine 684321-001

Before removing the system board, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn
the computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet,
and then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 48).

5. Remove the service access cover (see Service access cover on page 50).

6. Remove the following components:

a. Hard drive (see Hard drive on page 60)

b. Optical drive (see Optical drive on page 65)

c. Keyboard (see Keyboard on page 67)

d. Top cover (see Top cover on page 71)

e. Video card fan/heat sink assembly (see Video card fan/heat sink assembly on page 84)

f. Processor heat sink (see Processor heat sink on page 86)

When replacing the system board, be sure that the following components are removed from the
defective system board and installed on the replacement system board:

● SIM (see SIM on page 49)

● Memory modules (see Expansion memory modules on page 51)
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● WLAN module (see WLAN module on page 54)

● WWAN module (see WWAN module on page 56)

● Processor (see Processor on page 90)

● Graphics card (see Graphics card on page 88)

Remove the system board:

1. Position the computer right-side up, with the front toward you.

2. Remove the tape (1) that secures the cabling to the system board.

3. Remove the screws (2) that secure the plastic bracket to the system board, and then remove the
bracket (3).
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4. Disconnect the power jack (1), the network cable (2), the display cable (3), and the webcam
cable (4).

5. Remove the Phillips M2.0×3.0 screw (1) that secures the smart card reader to the system board.

6. Remove the three Torx 9M2.5×4.0 screws (2) that secure the system board to the base
enclosure.

7. Remove the two Torx 9M2.0×8.0 screws (3) that secure the system board to the optical drive
connector.
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8. Remove the system board (4) from the base enclosure.

Reverse the preceding procedure to install the system board.
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ExpressCard assembly

Description Spare part number

ExpressCard assembly for use in models without the Alcor chip upgrade 652680-001

ExpressCard assembly for use in models with the Alcor chip upgrade 684793-001

Before removing the ExpressCard assembly, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn
the computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet,
and then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 48).

5. Remove the service access cover (see Service access cover on page 50).

6. Remove the following components:

a. Hard drive (see Hard drive on page 60)

b. Optical drive (see Optical drive on page 65)

c. Keyboard (see Keyboard on page 67)

d. Top cover (see Top cover on page 71)

e. Video card fan/heat sink assembly (see Video card fan/heat sink assembly on page 84)

f. Processor heat sink (see Processor heat sink on page 86)

g. System board (see System board on page 107)

Remove the ExpressCard assembly:

1. Position the system board upright.
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2. Remove the Torx 8M2.5×4.0 screw that secures the ExpressCard assembly to the system
board.

3. Using a small screwdriver, press to release the latch (1) that secures the assembly to the
connector, and then lift the assembly up (2) and off the system board.

Reverse this procedure to install the ExpressCard assembly.
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RJ-11 connector cable

NOTE: The RJ-11 connector cable is included in the Cable Kit, spare part number 652662-001.

Before removing the RJ-11 connector cable, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn
the computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet,
and then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 48).

5. Remove the service access cover (see Service access cover on page 50).

6. Remove the following components:

a. Hard drive (see Hard drive on page 60)

b. Optical drive (see Optical drive on page 65)

c. Keyboard (see Keyboard on page 67)

d. Top cover (see Top cover on page 71)

e. Video card fan/heat sink assembly (see Video card fan/heat sink assembly on page 84)

f. Processor heat sink (see Processor heat sink on page 86)

g. System board (see System board on page 107)

Remove the RJ-11 connector cable:

1. Position the computer right-side up, with the front toward you.
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2. Remove the RJ-11 connector cable from the clips and routing channel built into the base
enclosure.

3. Remove the RJ-11 connector cable from the base enclosure.

Reverse this procedure to install the RJ-11 connector cable.
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Service access cover latch

NOTE: The service access cover latch is included with the base enclosure assembly, spare part
number 652649-001.

Before removing the service access cover latch, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn
the computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet,
and then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 48).

5. Remove the service access cover (see Service access cover on page 50).

6. Remove the following components:

a. Hard drive (see Hard drive on page 60)

b. Optical drive (see Optical drive on page 65)

c. Keyboard (see Keyboard on page 67)

d. Top cover (see Top cover on page 71)

e. Video card fan/heat sink assembly (see Video card fan/heat sink assembly on page 84)

f. Processor heat sink (see Processor heat sink on page 86)

g. System board (see System board on page 107)

h. RJ-11 connector cable (see RJ-11 connector cable on page 113)

Remove the service access cover latch:

1. Position the computer right-side up with the front toward you.

2. Remove the three Phillips M2.0×2.0 screws (1) that secure the service access cover latch to the
base enclosure.
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3. Remove the service access cover latch from the base enclosure (2), ensuring that the spring (3)
remains intact with the service access cover latch.

Reverse this procedure to install the service access cover latch.
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Battery latch

NOTE: The battery latch is included with the base enclosure assembly, spare part number
652649-001.

Before removing the battery latch, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn
the computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet,
and then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 48).

5. Remove the service access cover (see Service access cover on page 50).

6. Remove the following components:

a. Hard drive (see Hard drive on page 60)

b. Optical drive (see Optical drive on page 65)

c. Keyboard (see Keyboard on page 67)

d. Top cover (see Top cover on page 71)

e. Video card fan/heat sink assembly (see Video card fan/heat sink assembly on page 84)

f. Processor heat sink (see Processor heat sink on page 86)

g. System board (see System board on page 107)

h. RJ-11 connector cable (see RJ-11 connector cable on page 113)

i. Service access cover latch (see Service access cover latch on page 115)

Remove the battery latch:

1. Position the computer right-side up with the front toward you.

CAUTION: Ensure that the spring (1) remains intact while removing the battery latch.

2. Remove the two Phillips M2.0×2.0 screws (2) that secure the battery latch to the base enclosure.

Component replacement procedures 117



3. Remove the battery latch from the base enclosure (3).

Reverse this procedure to install the battery latch.

118 Chapter 4   Removal and replacement procedures



Security lock

NOTE: The security lock is included with the base enclosure assembly, spare part number
652649-001.

Before removing the security lock, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn
the computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet,
and then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 48).

5. Remove the service access cover (see Service access cover on page 50).

6. Remove the following components:

a. Hard drive (see Hard drive on page 60)

b. Optical drive (see Optical drive on page 65)

c. Keyboard (see Keyboard on page 67)

d. Top cover (see Top cover on page 71)

e. Video card fan/heat sink assembly (see Video card fan/heat sink assembly on page 84)

f. Processor heat sink (see Processor heat sink on page 86)

g. System board (see System board on page 107)

Remove the security lock:

1. Position the computer right-side up with the front toward you.

2. Remove the Torx 9M2.5×6.0 screw (1) that secures the security lock to the base enclosure.
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3. Remove the security lock (2) at an angle from the base enclosure.

Reverse this procedure to install the security lock.
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Display panel

Description Spare part number

HD+ WVA display panel 653271-001

FHD WVA display panel for use only with LTE module 653275-001

FHD WVA display panel 653273-001

NOTE: The display panel can be removed separately from the display assembly.

Before removing the display panel, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn
the computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet
and then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 48).

Remove the display panel:

1. Remove the display bezel:

a. Position the computer upright on a flat surface with the display panel open.

b. Remove the two rubber pads (1) that cover the display panel screws.

c. Remove the two Torx 9M2.5×5.0 screws (2) that secure the display bezel to the display
enclosure.

Component replacement procedures 121



d. Flex the top (1) of the bezel from the inside edge until it disengages from the display back
cover.

e. Flex the inside edge of the left side and the right side (2) of the bezel until it disengages
from the display back cover.

f. Flex the bottom (3) of the bezel from the inside edge until it disengages from the display
back cover.

g. Remove the display bezel from the display back cover (4).

2. Remove the six Torx 9M2.5×5.0 screws that secure the display panel to the display enclosure.

3. Disengage the display panel from the base enclosure by closing the display enclosure to 45
degrees while holding the sides of the display panel.

4. Remove the two pieces of tape that secure cables to the back of the display panel.

5. Remove the eight (1) Phillips M2.0×3.0 screws that secure the display panel to the display
hinges (four on either side).

122 Chapter 4   Removal and replacement procedures



6. Remove the display panel (2).

Reverse this procedure to install the display panel.
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Display assembly

Description Spare part number

39.6-cm (15.6 in) FHD RGB UWVA LCD display assembly with DreamColor:

For use in computer models without webcams 653277-001

For use in computer models with webcams 653278-001

NOTE: It is not necessary to remove the display panel in order to remove the display assembly.
However, for access to the webcam module, WLAN module, or WWAN module, you must remove the
display panel. For display panel removal instructions, see Display panel on page 121

Before removing the display assembly, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn
the computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet,
and then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 48).

5. (Optional) Remove the display panel (see Display panel on page 121).

6. Remove the service access cover (see Service access cover on page 50).

7. Disconnect the wireless antenna cables from the WLAN module (see WLAN module
on page 54) and the WWAN module (see WWAN module on page 56).

8. Remove the following components:

a. Hard drive (see Hard drive on page 60)

b. Optical drive (see Optical drive on page 65)

c. Keyboard (see Keyboard on page 67)

d. Top cover (see Top cover on page 71)

Remove the display assembly:

1. Position the computer right-side up, with the front toward you.

2. Remove the WLAN and WWAN antenna cables from the routing channel in the base enclosure
(1).

3. Remove the tape that covers the cables (2).

4. Thread the WLAN and WWAN antenna cables through the hole (3) and then back up
underneath the system board (4).
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5. Remove the tape from along the back edge of the system board (4).

CAUTION: Support the display assembly when removing the display screws in the following
steps. Failure to support the display assembly can result in damage to the assembly and other
components.

6. Remove the three Torx 9M2.5×6.0 screws (1) from the left hinge bracket and lower right hinge
bracket .

7. Remove the Torx 9M2.5×4.0 screw (2) from the upper right hinge bracket.

8. Position the computer with the back toward you.

9. Remove the four Torx 9M2.5×5.5 screws (1) on the back of each hinge.

10. Remove the four Torx 9M2.5×3.5 screws (2) that secure the logo nameplate to the base
enclosure.
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11. Lift the display assembly (3) straight up from the base enclosure and remove it.

12. If it is necessary to replace the display hinges, remove them from the hinge cover. The left and
right display hinges are available using spare part number 652646-001.

13. If it is necessary to remove the cable routing tray, remove the five Phillips M2.0×3.0 screws (1)
that secure the cable routing tray to the display enclosure. The cable routing tray is available in
the Raw Panel Support Kit, spare part number 657408-001.
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14. Pull the tray (2) away from the display enclosure. Remove the end cap (3) from the tray, and
then remove the cables (4).

15. If it is necessary to replace the webcam module or ambient light sensor from the display
enclosure, release the ZIF connector (1) for the webcam cable and disconnect the cable (2).
Then release the ZIF connector (3) for the ambient light sensor cable (4) and disconnect the
cable.

16. Remove the two Phillips screws (5) that secure the webcam to the display enclosure, and then
remove the webcam (6).
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17. If it is necessary to replace the webcam/ambient light sensor cable, disconnect the cable from
the ambient light sensor board (1), and then remove the cable (2).

18. If it is necessary to replace the WWAN antenna cables, detach the WWAN antenna transceivers
(1) from the adhesive on the back cover, and then release the cables from the clips (2) that
secure the cables to the display back cover.
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19. If it is necessary to replace the WLAN antenna cables, detach the WLAN antenna transceivers
(1) from the adhesive on the back cover, and then release the cables from the clips (2) that
secure the cables to the display back cover.

Reverse this procedure to reassemble and install the display assembly.
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5 Computer Setup

Starting Computer Setup
Computer Setup is a preinstalled, ROM-based utility that can be used even when the operating
system is not working or will not load.

NOTE: Some of the Computer Setup menu items listed in this guide may not be supported by your
computer.

NOTE: An external keyboard or mouse connected to a USB port can be used with Computer Setup
only if USB legacy support is enabled.

To start Computer Setup, follow these steps:

1. Turn on or restart the computer, and then press esc while the “Press the ESC key for Startup
Menu” message is displayed at the bottom of the screen.

2. Press f10 to enter BIOS Setup.

Using Computer Setup

Navigating and selecting in Computer Setup

The information and settings in Computer Setup are accessed from the File, Security, Diagnostics,
and System Configuration menus.

To navigate and select in Computer Setup, follow these steps:

1. Turn on or restart the computer, and then press esc while the “Press the ESC key for Startup
Menu” message is displayed at the bottom of the screen.

● To select a menu or a menu item, use the tab key and the keyboard arrow keys, and then
press enter, or use a pointing device to click the item.

● To scroll up and down, click the up arrow or the down arrow in the upper-right corner of the
screen, or use the up arrow key or the down arrow key.

● To close open dialog boxes and return to the main Computer Setup screen, press esc, and
then follow the on-screen instructions.
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NOTE: You can use either a pointing device (TouchPad, pointing stick, or USB mouse) or the
keyboard to navigate and make selections in Computer Setup.

2. Press f10 to enter BIOS Setup.

3. Select the File, Security, Diagnostics, or System Configuration menu.

To exit Computer Setup menus, choose one of the following methods:

● To exit Computer Setup menus without saving your changes, click the Exit icon in the lower-left
corner of the screen, and then follow the on-screen instructions.

– or –

Use the tab key and the arrow keys to select File > Ignore changes and exit, and then press
enter.

– or –

● To save your changes and exit Computer Setup menus, click the Save icon in the lower-left
corner of the screen, and then follow the on-screen instructions.

– or –

Use the tab key and the arrow keys to select File > Save changes and exit, and then press
enter.

Your changes go into effect when the computer restarts.

Restoring factory settings in Computer Setup

NOTE: Restoring defaults will not change the hard drive mode.

To return all settings in Computer Setup to the values that were set at the factory, follow these steps:

1. Turn on or restart the computer, and then press esc while the “Press the ESC key for Startup
Menu” message is displayed at the bottom of the screen.

2. Press f10 to enter BIOS Setup.

3. Use a pointing device or the arrow keys to select File > Restore defaults.

4. Follow the on-screen instructions.

5. To save your changes and exit, click the Save icon in the lower-left corner of the screen, and
then follow the on-screen instructions.

– or –

Use the arrow keys to select File > Save changes and exit, and then press enter.

Your changes go into effect when the computer restarts.

NOTE: Your password settings and security settings are not changed when you restore the factory
settings.
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Computer Setup menus
The menu tables in this section provide an overview of Computer Setup options.

NOTE: Some of the Computer Setup menu items listed in this chapter may not be supported by
your computer.

File menu

Select To do this

System Information ● View identification information for the computer and the
batteries in the system.

● View specification information for the processor, cache
and memory size, system ROM, video revision, and
keyboard controller version.

Set System Date and Time Set or change the date and time on the computer.

System Diagnostics Displays the following information:

● System Information

◦ Identification information for the computer and the
batteries in the system.

◦ Specification information for the processor, cache
and memory size, system ROM, video revision,
and keyboard controller version.

● Start-up Test—Verifies the system components needed
for starting the computer.

● Run-In Test—Runs a comprehensive check on system
memory.

● Hard Disk Test—Runs a comprehensive self-test on
any hard drive in the system.

● Memory Test—Runs a comprehensive test on any
memory installed in the computer.

● Battery Test—Runs a comprehensive test on any
batteries installed in the computer.

● Error Log—Displays a log file if any errors have
occurred.

Restore defaults Replace the configuration settings in Computer Setup with
the original factory settings. (Hard drive mode, password
settings, and security settings are not changed when you
restore the factory settings.)

Reset BIOS security to factory default Restore the BIOS security settings to the factory default.

Ignore changes and exit Cancel any changes entered during the current session.
Then, exit and restart the computer.

Save changes and exit Save any changes entered during the current session. Then,
exit and restart the computer. Your changes go into effect
when the computer restarts.
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Security menu

NOTE: Some of the menu items listed in this section may not be supported by your computer.

Select To do this

Administrator Tools

Setup BIOS Administrator Password Set up a BIOS administrator password.

User Management (requires a BIOS administrator password)

Create New BIOS User Account ● Select from a list of BIOS users.

● Select from a list of ProtectTools users.

Password Policy (requires a BIOS administrator password) Revise password policy criteria.

HP SpareKey Enable/disable HP SpareKey (enabled by default).

Always Prompt for HP SpareKey Enrollment Enable/disable HP SpareKey enrollment (enabled by
default).

Fingerprint Reset on Reboot (if present) Reset/clear the fingerprint reader ownership (select models
only; disabled by default).

User Tools

Change Password Enter, change, or delete a BIOS administrator password.

HP SpareKey Enrollment Enroll or reset HP SpareKey, which is a set of security
questions and answers used if you forget your password.

Anti Theft

AT-p Enable/disable Anti-Theft Protection.

DriveLock Passwords ● Enable/disable DriveLock on any computer hard drive
(enabled by default).

● Change a DriveLock user password or master
password.

NOTE: DriveLock settings are accessible only when you
enter Computer Setup by turning on (not restarting) the
computer.

Automatic DriveLock Enable/disable Automatic DriveLock support.

TPM Embedded Security Enable/disable support for Trusted Platform Module (TPM)
Embedded Security, which protects the computer from
unauthorized access to owner functions available in
Embedded Security for ProtectTools. For more information,
refer to the ProtectTools software Help.

NOTE: You must have a setup password to change this
setting.

Disk Sanitizer Run Disk Sanitizer to destroy all existing data on the primary
hard drive or the drive in the upgrade bay.

CAUTION: If you run Disk Sanitizer, the data on the
selected drive is destroyed permanently.

System IDs Enter a user-defined computer asset tracking number and
ownership tag.
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System Configuration menu

NOTE: Some of the listed System Configuration options may not be supported by your computer.

Select To do this

Language Change the Computer Setup language.

Boot Options ● Set a Startup Menu delay (in seconds).

● Set the Multiboot Express Boot Popup delay (in
seconds).

● Enable/disable Custom Logo (disabled by default).

● Enable/disable Display Diagnostic URL (enabled by
default).

● Enable/disable CD-ROM boot (disabled by default).

● Enable/disable SD Card boot (enabled by default).

● Enable/disable floppy boot (enabled by default).

● Enable/disable PXE Internal NIC boot (enabled by
default).

● Enable/Disable Unified Extensible Firmware Interface
(UEFI) Boot Mode (disabled by default).

● Set the Legacy Boot Order.

Device Configurations ● Enable/disable USB legacy support (enabled by
default). When enabled, USB legacy support allows the
following:

◦ Use of a USB keyboard in Computer Setup even
when a Windows operating system is not running.

◦ Startup from bootable USB devices, including a
hard drive, diskette drive, or optical drive
connected by a USB port to the computer.

● Select a parallel port mode: ECP (Enhanced
Capabilities Port), standard, bidirectional, or EPP
(Enhanced Parallel Port).

● Enable/disable fan always on while connected to an AC
outlet (enabled by default).

● Enable/disable Data Execution Prevention (select
models only). When enabled, the processor can disable
some virus code execution, which helps to improve
computer security (disabled by default).

● SATA (Serial Advanced Technology Attachment) device
mode. The following options are available:

◦ AHCI (Advanced Host Controller Interface)

◦ IDE (Integrated Drive Electronics)

◦ RAID (Redundant Array of Independent Disks)
(select models only)

134 Chapter 5   Computer Setup



Select To do this

NOTE: Availability of these options varies by computer
model.

● Enable/disable secondary battery fast charge (enabled
by default).

● Enable/disable HP QuickLook (enabled by default).

● Enable/disable Preboot Authentication on HP
QuickLook Boot (enabled by default).

● Enable/disable HP QuickWeb (enabled by default).

● Enable/disable HP QuickWeb: Write Protect (disabled
by default).

● Enable/disable Virtualization Technology (select models
only; disabled by default).

● Enable/disable TXT (Intel Trusted Execution
Technology) (select models only; disabled by default).

● Multi Core CPU (enabled by default).

● Intel HT Technology (enabled by default).

● Enable/disable Wake on USB (enabled by default).

● Enable/disable Num lock state at boot (disabled by
default).
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Select To do this

Built-In Device Options ● Enable/disable the wireless button state (enabled by
default).

● Enable/disable embedded WLAN device radio (select
models only; enabled by default).

● Enable/disable the embedded Bluetooth device radio
(enabled by default).

● Enable/disable the Network Interface Controller (NIC)
(enabled by default).

● Enable/disable LAN/WLAN switching (disabled by
default).

● Set the wake on LAN state. Options include the
following:

◦ Disabled

◦ Boot to Network

◦ Follow Boot Order

● Enable/disable the Ambient Light Sensor.

● Enable/disable the Notebook Upgrade Bay device
(enabled by default).

● Enable/disable the fingerprint device (enabled by
default).

● Enable/disable the integrated camera (enabled by
default).

● Enable/disable the Power Monitor Circuit (enabled by
default).

● Enable/disable the audio device (enabled by default).

● Enable/disable a modem device (enabled by default).

● Enable/disable the microphone (enabled by default).

● Enable/disable the internal speakers (enabled by
default).
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Select To do this

Port Options NOTE: All port options are enabled by default.

● Enable/disable the serial port.

● Enable/disable the parallel port.

● Enable/disable the flash media reader.

● Enable/disable the USB port.

CAUTION: Disabling the USB port also disables
MultiBay devices and ExpressCard devices on the
advanced port replicator.

● Enable/disable the 1394 port.

● Enable/disable the ExpressCard slot.

● Enable/disable the smart card slot.

● Enable/disable the eSATA port.

AMT Options ● Enable/disable Firmware Verbosity.

● Enable/disable AMT Setup Prompt (Ctrl+P).

● Enable/disable USB Key Provisioning Support.

● Enable/disable Unconfigure AMT on next boot.

● Select Terminal Emulation Mode.

◦ ANSI

◦ VT100

● Enable/disable Firmware Progress Event Support.

● Enable/disable Initiate Intel CIRA.

Set Security Level Change, view, or hide security levels for all BIOS menu
items.

Restore Security Defaults Restore the default security settings.
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6 Specifications

Computer specifications

 Metric U.S.

Dimensions

Length 25.2 cm 9.9 in

Width 37.4 cm 14.7 in

Height (front to rear) 3.2 to 3.7 cm 1.28 to 1.45 in

Weight (equipped with 39.6-cm (15.6-in) HD+ display, NV
Graphics, DVD drive, 1-GB DIMM, 160-GB hard drive,
WLAN module, 8-cell battery)

2.89 kg 6.37 lbs

Input power

Operating voltage 19.0 V dc @ 4.74 A – 90 W

Operating current 4.74 A

Temperature

Operating 5°C to 35°C 41°F to 95°F

Relative humidity

Operating 10% to 90%

Nonoperating 5% to 95%

Maximum altitude (unpressurized)

Operating (14.7 to 10.1 psia) -15 m to 3,048 m 50 ft to 10,000 ft

Nonoperating (14.7 to 4.4 psia) -15 m to 12,192 m -50 ft to 40,000 ft

Shock

Operating 125 g, 2 ms, half-sine

Nonoperating 200 g, 2 ms, half-sine

Random vibration

Operating 0.75 g zero-to-peak, 10 Hz to 500 Hz, 0.25 oct/min sweep
rate
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 Metric U.S.

Nonoperating 1.50 g zero-to-peak, 10 Hz to 500 Hz, 0.5 oct/min sweep rate

NOTE: Applicable product safety standards specify thermal limits for plastic surfaces. The computer operates well within
this range of temperatures.

39.6-cm (15.6-in) HD+ display specifications

 Metric U.S.

Dimensions

Height 20.9 cm 8.25 in

Width 35.9 cm 14.15 in

Diagonal 39.6 cm 15.6 in

Surface treatment Anti-glare

Contrast ratio 300:1 (typical)

Refresh rate 60 Hz

Brightness 200 nits (typical)

Pixel resolution

Pitch 0.2151 mm

Format 1600 × 900

Configuration RGB stripe

Backlight LED

PPI 118 ppi

Viewing angle 30/30/20/10 (Left/Right/Down/Up) (minimum) or

45/45/35/25 (Left/Right/Down/Up) (typical)
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39.6-cm (15.6-in) FHD display specifications

 Metric U.S.

Dimensions

Height 20.9 cm 8.25 in

Width 35.9 cm 14.15 in

Diagonal 39.6 cm 15.6 in

Surface treatment Anti-glare

Contrast ratio 300:1 (typical)

Refresh rate 60 Hz

Brightness 220 nits (typical)

Pixel resolution

Pitch 0.179 × 0.179 mm

Format 1920 × 1080

Configuration RGB stripe

Backlight LED

PPI 142 ppi

Viewing angle 60/60/50/50 (Left/Right/Down/Up) (minimum) or

70/70/60/60 (Left/Right/Down/Up) (typical)
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Hard drive specifications

 500-GB* 320-GB* 250-GB*

Dimensions

Height 9.5 mm 9.5 mm 9.5 mm

Width 70 mm 70 mm 70 mm

Weight 101 g 101 g 101 g

Interface type SATA SATA SATA

Transfer rate 100 MB/sec 100 MB/sec 100 MB/sec

Security ATA security ATA security ATA security

Seek times (typical read, including setting)

Single track 3 ms 3 ms 3 ms

Average 13 ms 13 ms 13 ms

Maximum 24 ms 24 ms 24 ms

Logical blocks 1,048,576,000 625,141,400 488,397,168

Disc rotational speed 7200 rpm 7200 rpm 7200 rpm

Operating temperature 5°C to 55°C (41°F to 131°F)

*1 GB = 1 billion bytes when referring to hard drive storage capacity. Actual accessible capacity is less. Actual drive
specifications may differ slightly.

NOTE: Certain restrictions and exclusions apply. Contact technical support for details.
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DVD±RW and CD-RW SuperMulti DL Combo Drive
specifications

Applicable disc Read:

CD-DA, CD+(E)G, CD-MIDI, CD-TEXT, CD-
ROM, CD-ROM XA, MIXED MODE CD, CD-I,
CD-I Bridge (Photo-CD, Video CD),
Multisession CD (Photo-CD, CD-EXTRA,
Portfolio, CD-R, CD-RW), CD-R, CD-RW, DVD-
ROM (DVD-5, DVD-9, DVD-10, DVD-18), DVD-
R, DVD-RW, DVD+R, DVD+RW, DVD-RAM

Write:

CD-R and CD-RW

DVD+R, DVD+RW, DVD-R, DVD-
RW, DVD-RAM

Center hole diameter 1.5 cm (0.59 in)

Disc diameter

Standard disc 12 cm (4.72 in)

Mini disc 8 cm (3.15 in)

Disc thickness 1.2 mm (0.047 in)

Track pitch 0.74 µm

Access time CD DVD

Random < 175 ms < 230 ms

Full stroke < 285 ms < 335 ms

Audio output level Line-out, 0.7 Vrms

Cache buffer 2 MB

Data transfer rate

24X CD-ROM 3,600 KB/sec

8X DVD-ROM 10,800 KB/sec

24X CD-R 3,600 KB/sec

16X CD-RW 2,400 KB/sec

8X DVD+R 10,800 KB/sec

4X DVD+RW 5,400 KB/sec

8X DVD-R 10,800 KB/sec

4X DVD-RW 5,400 KB/sec

2.4X DVD+R(9) 2,700 KB/sec

5X DVD-RAM 6,750 KB/sec

Transfer mode Multiword DMA Mode

Startup time < 15 seconds

Stop time < 6 seconds
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Blu-ray Disc ROM DVD±RW SuperMulti DL Combo Drive

Applicable disc Read: Write:

 CD-DA, CD+(E)G, CD-MIDI, CDTEXT,
CD-ROM, CD-ROM XA,
MIXED MODE CD, CD-I, CD-I Bridge
(Photo-CD, Video CD), Multisession
CD (Photo-CD, CD-EXTRA, Portfolio,
CD-R, CD-RW), CD-R, CD-RW,
DVDROM (DVD-5, DVD-9, DVD-10,
DVD-18), DVD-R, DVD-RW, DVD+R,
DVD+RW, DVD-RAM, HD-
ROM (Single Layer), HD-ROM (Dual
Layer), HD DVD-R, HD DVD-R for
Dual Layer, HD DVD-RW

CD-R and CD-RW DVD+R, DVD+R(9),
DVD+RW, DVD-R, DVD-R(9),DVD-RW,
DVD-RAM

Access time CD DVD HD

Random 170 ms 170 ms 230 ms

Cache buffer 8 MB

Data transfer rate

24X CD-ROM 3,600 KB/sec

8X DVD 10,800 KB/sec

24X CD-R 3,600 KB/sec

16X CD-RW 2,400 KB/sec

8X DVD+R 10,800 KB/sec

4X DVD+RW 5,400 KB/sec

8X DVD-R 10,800 KB/sec

4X DVD-RW 5,400 KB/sec

2.4X DVD+R(9) 2,700 KB/sec

5X DVD-RAM 6,750 KB/sec

1X BD-ROM 4,500 KB/sec

1X BD-R read 4,500 KB/sec

1X BD-RE read 4,500 KB/sec

Transfer mode Multiword DMA Mode
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Blu-ray Disc ROM Combo Drive

Applicable disc Read: Write:

 CD-DA, CD+(E)G, CD-MIDI, CD-TEXT,
CD-ROM, CD-ROM XA, MIXED MODE
CD, CD-I, CD-I Bridge (Photo-CD,
Video CD), Multisession CD (Photo-
CD, CD-EXTRA, Portfolio, CD-R, CD-
RW), CD-R, CD-RW, DVD-ROM
(DVD-5, DVD-9, DVD-10, DVD-18),
DVD-R, DVD-RW, DVD+R, DVD+RW.
DVD-RAM, BD-ROM, BD-R, BD-RE

CD-R, CD-RW, DVD+R, DVD+R(9),
DVD+RW, DVD-R, DVD-R(9), DVD-RW,
DVD-RAM

Access time CD DVD BD-ROM

Random <190 ms <190 ms <230 ms

Maximum Media Capacity (read) 50 GB

Maximum Media Capacity (write) 8.5 GB

Data transfer rate

24X CD-ROM 3,600 KB/sec

8X DVD 10,800 KB/sec

16X CD-R 2,400 KB/sec

10X CD-RW 1.500 KB/sec

8X DVD+R 10,800 KB/sec

8X DVD+RW 10,800 KB/sec

8X DVD-R 10,800 KB/sec

6X DVD-RW 8,100 KB/sec

4X DVD+R Dual Layer 5,400 KB/sec

4X DVD-R Dual Layer 5,400 KB/sec

5X DVD-RAM 6,750 KB/sec

2X BD-ROM 9,000 KB/sec
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DVD-ROM Drive specifications

Applicable disc DVD-ROM (DVD-5, DVD-9, DVD-10, DVD-18, CD-ROM (Mode 1 and 2), CD Digital
Audio, CD-XA ready (Mode 2, Form 1 and Form 2), CD-I (Mode 2, Form 1 and Form
2), CD-R, CD-RW, Photo CD (single and multisession), CD-Bridge

Center hole diameter 1.5 cm (0.59 in)

Disc diameter  

Standard disc

Mini disc

12 cm (4.72 in)

8 cm (3.15 in)

Disc thickness 1.2 mm (0.047 in)

Track pitch 0.74 µm

Access time CD DVD

Random < 100 ms < 125 ms

Full stroke < 175 ms < 225 ms

Audio output level Line-out, 0.7 Vrms

Cache buffer 512 KB

Data transfer rate  

CD-R (24X) 3600 KB/s (150 KB/s at 1X CD rate)

CD-RW (10X) 1500 KB/s (150 KB/s at 1X CD rate)

CD-ROM (24X) 3600 KB/s (150 KB/s at 1X CD rate)

DVD (8X) 10,800 KB/s (1,352 KB/s at 1X DVD rate)

Multiword DMA mode 2 16.6 MB/s

Startup time < 10 seconds

Stop time < 3 seconds
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7 Backup and recovery

Windows 7
To protect your information, use Windows Backup and Restore to back up individual files and folders,
back up your entire hard drive (select models only), create system repair discs (select models only),
or create system restore points. In case of system failure, you can use the backup files to restore the
contents of your computer.

Windows Backup and Restore provides the following options:

● Creating a system repair disc (select models only)

● Backing up individual files and folders

● Creating a system image (select models only)

● Scheduling automatic backups (select models only)

● Creating system restore points

● Recovering individual files

● Restoring the computer to a previous state

● Recovering information using recovery tools

NOTE: For detailed instructions, perform a search for these topics in Help and Support.

NOTE: In case of system instability, HP recommends that you print the recovery procedures and
save them for later use.

Backing up your information

Recovery after a system failure is as complete as your most current backup. You should create
system repair discs (select models only) and your initial backup immediately after software setup. As
you add new software and data files, you should continue to back up your system on a regular basis
to maintain a reasonably current backup. The system repair discs (select models only) are used to
start up (boot) the computer and repair the operating system in case of system instability or failure.
Your initial and subsequent backups allow you to restore your data and settings if a failure occurs.

You can back up your information to an optional external hard drive, a network drive, or discs.
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Note the following when backing up:

● Store personal files in the Documents library, and back it up regularly.

● Back up templates that are stored in their associated programs.

● Save customized settings that appear in a window, toolbar, or menu bar by taking a screen shot
of your settings. The screen shot can be a time-saver if you have to reset your preferences.

To create a screen shot:

1. Display the screen you want to save.

2. Copy the screen image:

To copy only the active window, press alt+fn+prt sc.

To copy the entire screen, press fn+prt sc.

3. Open a word-processing document, and then select Edit > Paste.

The screen image is added to the document.

4. Save the document.

● When backing up to discs, use any of the following types of discs (purchased separately): CD-R,
CD-RW, DVD+R, DVD+R DL, DVD-R, DVD-R DL, or DVD±RW. The discs you use will depend
on the type of optical drive installed in your computer.

NOTE: DVDs and DVDs with double-layer (DL) support store more information than CDs, so
using them for backup reduces the number of recovery discs required.

● When backing up to discs, number each disc before inserting it into the optical drive of the
computer.

To create a backup using Backup and Restore, follow these steps:

NOTE: Be sure that the computer is connected to AC power before you start the backup process.

NOTE: The backup process may take over an hour, depending on file size and the speed of the
computer.

1. Select Start > All Programs > Maintenance > Backup and Restore.

2. Follow the on-screen instructions to set up your backup, create a system image (select models
only), or create a system repair disc (select models only).

NOTE: Windows includes the User Account Control feature to improve the security of your
computer. You may be prompted for your permission or password for tasks such as installing
software, running utilities, or changing Windows settings. Refer to Windows Help and Support
for more information.
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Performing a recovery

In case of system failure or instability, the computer provides the following tools to recover your files:

● Windows recovery tools: You can use Windows Backup and Restore to recover information you
have previously backed up. You can also use Windows Startup Repair to fix problems that might
prevent Windows from starting correctly.

● f11 recovery tools: You can use the f11 recovery tools to recover your original hard drive image.
The image includes the Windows operating system and software programs installed at the
factory.

NOTE: If you are unable to boot (start up) your computer and you cannot use the system repair
discs you previously created (select models only), you must purchase a Windows 7 operating system
DVD to reboot the computer and repair the operating system. For additional information, refer to the
“Using a Windows 7 operating system DVD (purchased separately)” section in this guide.

Using the Windows recovery tools

To recover information you previously backed up, follow these steps:

1. Select Start > All Programs > Maintenance > Backup and Restore.

2. Follow the on-screen instructions to recover your system settings, your computer (select models
only), or your files.

NOTE: Windows includes the User Account Control feature to improve the security of your
computer. You may be prompted for your permission or password for tasks such as installing
software, running utilities, or changing Windows settings. Refer to Windows Help and Support for
more information.

To recover your information using Startup Repair, follow these steps:

CAUTION: Using Startup Repair completely erases hard drive contents and reformats the hard
drive. All files you have created and any software installed on the computer are permanently
removed. When reformatting is complete, the recovery process restores the operating system, as well
as the drivers, software, and utilities from the backup used for recovery.

1. If possible, back up all personal files.

2. If possible, check for the presence of the Windows partition and the HP Recovery partition.

To check for the Windows partition, select Start > Computer.

To check for the HP Recovery partition, select Start, right-click Computer, click Manage, and
then click Disk Management.

NOTE: If the Windows partition and the HP Recovery partition are not listed, you must recover
your operating system and programs using the Windows 7 operating system DVD and the Driver
Recovery disc (both purchased separately). For additional information, refer to the “Using a
Windows 7 operating system DVD (purchased separately)” section in this guide.

3. If the Windows partition and the HP Recovery partition are listed, restart the computer, and then
press f8 before the Windows operating system loads.

4. Select Startup Repair.

5. Follow the on-screen instructions.
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NOTE: For additional information on recovering information using the Windows tools, perform a
search for these topics in Help and Support.

Using f11

CAUTION: Using f11 completely erases hard drive contents and reformats the hard drive. All files
you have created and any software installed on the computer are permanently removed. The f11
recovery tool reinstalls the operating system and HP programs and drivers that were installed at the
factory. Software not installed at the factory must be reinstalled.

To recover the original hard drive image using f11, follow these steps:

1. If possible, back up all personal files.

2. If possible, check for the presence of the HP Recovery partition: select Start, right-click
Computer, click Manage, and then click Disk Management.

NOTE: If the HP Recovery partition is not listed, you must recover your operating system and
programs using the Windows 7 operating system DVD and the Driver Recovery disc (both
purchased separately). For additional information, refer to the “Using a Windows 7 operating
system DVD (purchased separately)” section in this guide.

3. If the HP Recovery partition is listed, restart the computer, and then press esc while the “Press
the ESC key for Startup Menu” message is displayed at the bottom of the screen.

4. Press f11 while the “Press <F11> for recovery” message is displayed on the screen.

5. Follow the on-screen instructions.

Using a Windows 7 operating system DVD (purchased separately)

If you are unable to boot (start up) your computer and you cannot use the system repair discs you
previously created (select models only), you must purchase a Windows 7 operating system DVD to
reboot the computer and repair the operating system. Make sure that your most recent backup
(stored on discs or on an external drive) is easily accessible. To order a Windows 7 operating system
DVD, go to http://www.hp.com/support, select your country or region, and then follow the on-screen
instructions. You can also order the DVD by calling technical support. For contact information, refer to
the Worldwide Telephone Numbers booklet included with the computer.

CAUTION: Using a Windows 7 operating system DVD completely erases hard drive contents and
reformats the hard drive. All files you have created and any software installed on the computer are
permanently removed. When reformatting is complete, the recovery process helps you restore the
operating system, as well as drivers, software, and utilities.

To initiate recovery using a Windows 7 operating system DVD, follow these steps:

NOTE: This process takes several minutes.

1. If possible, back up all personal files.

2. Restart the computer, and then insert the Windows 7 operating system DVD into the optical
drive before the Windows operating system loads.

3. When prompted, press any keyboard key.

4. Follow the on-screen instructions.

5. Click Next.
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6. Select Repair your computer.

7. Follow the on-screen instructions.

Windows Vista
To protect your information, use the Backup and Restore Center to back up individual files and
folders, back up your entire hard drive (select models only), or create system restore points. In case
of system failure, you can use the backup files to restore the contents of your computer.

The Backup and Restore Center provides the following options:

● Backing up individual files and folders

● Backing up the entire hard drive (select models only)

● Scheduling automatic backups (select models only)

● Creating system restore points

● Recovering individual files

● Restoring the computer to a previous state

● Recovering information using recovery tools

NOTE: For detailed instructions, perform a search for these topics in Help and Support.

NOTE: In case of system instability, HP recommends that you print the recovery procedures and
save them for later use.

Backing up your information

Recovery after a system failure is as complete as your most current backup. You should create your
initial backup immediately after software setup. As you add new software and data files, you should
continue to back up your system on a regular basis to maintain a reasonably current backup.

You can back up your information to an optional external hard drive, a network drive, or discs.

Note the following when backing up:

● Store personal files in the Documents folder, and back it up regularly.

● Back up templates that are stored in their associated programs.

● Save customized settings that appear in a window, toolbar, or menu bar by taking a screen shot
of your settings. The screen shot can be a time-saver if you have to reset your preferences.

To create a screen shot:

1. Display the screen you want to save.

2. Copy the screen image:

To copy only the active window, press alt+fn+prt sc.

To copy the entire screen, press fn+prt sc.

3. Open a word-processing document, and then select Edit > Paste.
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The screen image is added to the document.

4. Save the document.

● When backing up to discs, use any of the following types of discs (purchased separately): CD-R,
CD-RW, DVD+R, DVD+R DL, DVD-R, DVD-R DL, or DVD±RW. The discs you use will depend
on the type of optical drive installed in your computer.

NOTE: DVDs and DVDs with double-layer (DL) support store more information than CDs, so
using them for backup reduces the number of recovery discs required.

● When backing up to discs, number each disc before inserting it into the optical drive of the
computer.

To create a backup using Backup and Restore Center, follow these steps:

NOTE: Be sure that the computer is connected to AC power before you start the backup process.

NOTE: The backup process may take over an hour, depending on file size and the speed of the
computer.

1. Select Start > All Programs > Maintenance > Backup and Restore Center.

2. Follow the on-screen instructions to back up your entire computer (select models only) or your
files.

NOTE: Windows includes the User Account Control feature to improve the security of your
computer. You may be prompted for your permission or password for tasks such as installing
software, running utilities, or changing Windows settings. Refer to Windows Help and Support
for more information.

Performing a recovery

In case of system failure or instability, the computer provides the following tools to recover your files:

● Windows recovery tools: You can use the Backup and Restore Center to recover information
you have previously backed up. You can also use Windows Startup Repair to fix problems that
might prevent Windows from starting correctly.

● f11 recovery tools: You can use the f11 recovery tools to recover your original hard drive image.
The image includes the Windows operating system and software programs installed at the
factory.

NOTE: If you are unable to boot (start up) your computer, you must purchase a Windows Vista®
operating system DVD to reboot the computer and repair the operating system. For additional
information, refer to the “Using a Windows Vista operating system DVD (purchased separately)”
section in this guide.

Using the Windows recovery tools

To recover information you previously backed up, follow these steps:

1. Select Start > All Programs > Maintenance > Backup and Restore Center.

2. Follow the on-screen instructions to recover your entire computer (select models only) or your
files.
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NOTE: Windows includes the User Account Control feature to improve the security of your
computer. You may be prompted for your permission or password for tasks such as installing
software, running utilities, or changing Windows settings. Refer to Windows Help and Support for
more information.

To recover your information using Startup Repair, follow these steps:

CAUTION: Using Startup Repair completely erases hard drive contents and reformats the hard
drive. All files you have created and any software installed on the computer are permanently
removed. When reformatting is complete, the recovery process restores the operating system, as well
as the drivers, software, and utilities from the backup used for recovery.

1. If possible, back up all personal files.

2. If possible, check for the presence of the Windows partition and the HP Recovery partition. To
find the partitions, select Start > Computer.

NOTE: If the Windows partition and the HP Recovery partition have been deleted, you must
recover your operating system and programs using the Windows Vista operating system DVD
and the Driver Recovery disc (both purchased separately). For additional information, refer to
the “Using a Windows Vista operating system DVD (purchased separately)” section in this guide.

3. Restart the computer, and then press f8 before the Windows operating system loads.

4. Select Repair your computer.

5. Follow the on-screen instructions.

NOTE: For additional information on recovering information using the Windows tools, perform a
search for these topics in Help and Support.

Using f11

CAUTION: Using f11 completely erases hard drive contents and reformats the hard drive. All files
you have created and any software installed on the computer are permanently removed. The f11
recovery tool reinstalls the operating system and HP programs and drivers that were installed at the
factory. Software not installed at the factory must be reinstalled.

To recover the original hard drive image using f11, follow these steps:

1. If possible, back up all personal files.

2. If possible, check for the presence of the HP Recovery partition. To find the partition, select
Start > Computer.

NOTE: If the HP Recovery partition has been deleted, you must recover your operating system
and programs using the Windows Vista operating system DVD and the Driver Recovery disc
(both purchased separately). For additional information, refer to the “Using a Windows Vista
operating system DVD (purchased separately)” section in this guide.

3. Turn on or restart the computer, and then press esc while the “Press the ESC key for Startup
Menu” message is displayed at the bottom of the screen.

4. Press f11 while the “Press <F11> for recovery” message is displayed on the screen.

5. Follow the on-screen instructions.
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Using a Windows Vista operating system DVD (purchased separately)

If you are unable to boot (start up) your computer, you must purchase a Windows Vista operating
system DVD to reboot the computer and repair the operating system. Make sure that your most
recent backup (stored on discs or on an external drive) is easily accessible. To order a Windows Vista
operating system DVD, go to http://www.hp.com/support, select your country or region, and then
follow the on-screen instructions. You can also order the DVD by calling technical support. For
contact information, refer to the Worldwide Telephone Numbers booklet included with the computer.

CAUTION: Using a Windows Vista operating system DVD completely erases hard drive contents
and reformats the hard drive. All files you have created and any software installed on the computer
are permanently removed. When reformatting is complete, the recovery process helps you restore the
operating system, as well as drivers, software, and utilities.

To initiate recovery using a Windows Vista operating system DVD, follow these steps:

NOTE: This process takes several minutes.

1. If possible, back up all personal files.

2. Restart the computer, and then insert the Windows Vista operating system DVD into the optical
drive before the Windows operating system loads.

3. When prompted, press any keyboard key.

4. Follow the on-screen instructions.

5. Click Next.

6. Select Repair your computer.

7. Follow the on-screen instructions.
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8 Power cord set requirements

The wide range input feature of the computer permits it to operate from any line voltage from 100 to
120 volts AC, or from 220 to 240 volts AC.

The 3-conductor power cord set included with the computer meets the requirements for use in the
country or region where the equipment is purchased.

Power cord sets for use in other countries and regions must meet the requirements of the country or
region where the computer is used.

Requirements for all countries and regions
The requirements listed below are applicable to all countries and regions:

● The length of the power cord set must be at least 1.5 m (5.0 ft) and no more than 2.0 m (6.5 ft).

● All power cord sets must be approved by an acceptable accredited agency responsible for
evaluation in the country or region  where the power cord set will be used.

● The power cord sets must have a minimum current capacity of 10 amps and a nominal voltage
rating of 125 or 250 V AC, as required by the power system of each country or region.

● The appliance coupler must meet the mechanical configuration of an EN 60 320/IEC 320
Standard Sheet C13 connector for mating with the appliance inlet on the back of the computer.
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Requirements for specific countries and regions

Country/region Accredited agency Applicable note number

Australia EANSW 1

Austria OVE 1

Belgium CEBC 1

Canada CSA 2

Denmark DEMKO 1

Finland FIMKO 1

France UTE 1

Germany VDE 1

Italy IMQ 1

Japan METI 3

The Netherlands KEMA 1

Norway NEMKO 1

The People's Republic of China CCC 5

South Korea EK 4

Sweden SEMKO 1

Switzerland SEV 1

Taiwan BSMI 4

The United Kingdom BSI 1

The United States UL 2

1. The flexible cord must be Type HO5VV-F, 3-conductor, 1.0-mm² conductor size. Power cord set fittings (appliance
coupler and wall plug) must bear the certification mark of the agency responsible for evaluation in the country or region
where it will be used.

2. The flexible cord must be Type SPT-3 or equivalent, No. 18 AWG, 3-conductor. The wall plug must be a two-pole
grounding type with a NEMA 5-15P (15 A, 125 V) or NEMA 6-15P (15 A, 250 V) configuration.

3. The appliance coupler, flexible cord, and wall plug must bear a “T” mark and registration number in accordance with the
Japanese Dentori Law. The flexible cord must be Type VCT or VCTF, 3-conductor, 1.00-mm² conductor size. The wall
plug must be a two-pole grounding type with a Japanese Industrial Standard C8303 (7 A, 125 V) configuration.

4. The flexible cord must be Type RVV, 3-conductor, 0.75-mm² conductor size. Power cord set fittings (appliance coupler
and wall plug) must bear the certification mark of the agency responsible for evaluation in the country or region where it
will be used.

5. The flexible cord must be Type VCTF, 3-conductor, 0.75-mm² conductor size. Power cord set fittings (appliance coupler
and wall plug) must bear the certification mark of the agency responsible for evaluation in the country or region where it
will be used.
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9 Recycling

Battery
When a battery has reached the end of its useful life, do not dispose of the battery in general
household waste. Follow the local laws and regulations in your area for computer battery disposal.

Display
WARNING! The backlight contains mercury. Exercise caution when removing and handling the
backlight to avoid damaging this component and causing exposure to the mercury.

CAUTION: The procedures in this chapter can result in damage to display components. The only
components intended for recycling purposes are the LCD panel and the backlight. When you remove
these components, handle them carefully.

NOTE: Materials Disposal. This HP product contains mercury in the backlight in the display
assembly that might require special handling at end-of-life. Disposal of mercury may be regulated
because of environmental considerations. For disposal or recycling information, contact your local
authorities, or see the Electronic Industries Alliance (EIA) Web site at http://www.eiae.org.

This section provides disassembly instructions for the display assembly. The display assembly must
be disassembled to gain access to the backlight (1) and the liquid crystal display (LCD) panel (2).

NOTE: The procedures provided in this chapter are general disassembly instructions. Specific
details, such as screw sizes, quantities, and locations, and component shapes and sizes, can vary
from one computer model to another.
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Perform the following steps to disassemble the display assembly:

1. Remove all screw covers (1) and screws (2) that secure the display bezel to the display
assembly.

2. Lift up and out on the left and right inside edges (1) and the top and bottom inside edges (2) of
the display bezel until the bezel disengages from the display assembly.

3. Remove the display bezel (3).
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4. Disconnect all display panel cables (1) from the display inverter and remove the inverter (2).

5. Remove all screws (1) that secure the display panel assembly to the display enclosure.

6. Remove the display panel assembly (2) from the display enclosure.

7. Turn the display panel assembly upside-down.

8. Remove all screws that secure the display panel frame to the display panel.

9. Use a sharp-edged tool to cut the tape (1) that secures the sides of the display panel to the
display panel frame.
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10. Remove the display panel frame (2) from the display panel.

11. Remove the screws (1) that secure the backlight cover to the display panel.

12. Lift the top edge of the backlight cover (2) and swing it outward.

13. Remove the backlight cover.

14. Turn the display panel right-side up.
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15. Remove the backlight cables (1) from the clip (2) in the display panel.

16. Turn the display panel upside-down.

WARNING! The backlight contains mercury. Exercise caution when removing and handling the
backlight to avoid damaging this component and causing exposure to the mercury.

17. Remove the backlight frame from the display panel.
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18. Remove the backlight from the backlight frame.

19. Disconnect the display panel cable (1) from the LCD panel.

20. Remove the screws (2) that secure the LCD panel to the display rear panel.

21. Release the LCD panel (3) from the display rear panel.

22. Release the tape (4) that secures the LCD panel to the display rear panel.

23. Remove the LCD panel.

24. Recycle the LCD panel and backlight.
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Index

Symbols/Numerics
1394 port, identifying 14

A
AC adapter, spare part number

32, 36
ambient light sensor

identifying 15
spare part number 28, 40

AMT options 137
AMT Setup Prompt (Ctrl-P)

137
Firmware Progress Event

Support 137
Firmware Verbosity 137
Initiate Intel CIRA 137
Terminal Emulation Mode 137
Unconfigure AMT on next

boot 137
USB Key Provisioning

Support 137
antennas, disconnecting 54, 56
Anti Theft 133
audio, product description 3
audio-in (microphone) jack 13
audio-out (headphone) jack 13
audio/USB 3.0 board

removal 94
spare part number 37, 94

B
backing up files 146
Backup and Restore 146, 147
Backup and Restore Center 150,

151
base enclosure, spare part

number 25, 37

battery
removal 48
spare part number 26, 36, 48

battery bay, identifying 17
battery connector, accessory 17
battery cover, illustrated 29
battery latch removal 117
battery light 12
battery release latch 17
BIOS administrator password

133
Blu-ray Disc R/RE DVD±RW

SuperMulti DL Drive
removal 65
spare part number 25, 31, 40,

65
Blu-ray Disc ROM Drive,

specifications 144
Blu-ray Disc ROM DVD±RW

SuperMulti DL Combo Drive
removal 65
spare part number 25, 32, 40,

65
specifications 143

Bluetooth cable, illustrated 30
Bluetooth compartment,

identifying 18
Bluetooth module

removal 58
spare part number 22, 36, 58

boot options 134
boot order 134
bottom cover release latch,

identifying 17
built-in device

ambient light sensor 136
audio device 136
Bluetooth device radio 136
fingerprint reader 136

integrated camera 136
internal speakers 136
LAN/WLAN switching 136
microphone 136
modem 136
Network Interface Controller

(LAN) 136
Notebook Upgrade Bay 136
Power Monitor Circuit 136
Wake on LAN 136
wireless button 136
WLAN device radio 136

built-in device options 136
buttons

calculator 10
center TouchPad 7
left TouchPad 7
optical drive eject button 13
pointing stick 7
power 9
QuickWeb 10
right TouchPad 7
TouchPad on/off 7, 9
volume mute 9
wireless 9

C
Cable Kit

contents 30
spare part number 26, 30, 37

cables, service considerations 43
calculator

button, identifying 10
light 8

caps lock light, identifying 8
chipset, product description 1
components

bottom 17
display 15
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front 12
left side 14
rear 16
right side 13
top 7

Computer Setup
File menu 132
navigating and selecting 130
restoring factory settings 131
Security menu 133
System Configuration menu

134
computer specifications 138
connector, power 16
connectors, service

considerations 43
creating a backup 146

D
device configurations 134
disk sanitizer 133
diskette drive, precautions 43
display assembly

removal 124
spare part number 21, 40,

124
display bezel

removal 121
spare part number 27, 37

display cable kit
spare part number 27, 37

display component recycling 156
display components, spare part

number 27
display hinge covers, spare part

number 37
display hinges, spare part

number 27, 37
display latch button, illustrated 29
display latch kit, spare part

number 37
display panel

product description 1
removal 121
spare part number 27, 40,

121
display panel support kit, spare

part number 40
display release latch 12
display specifications 139, 140

DisplayPort, identifying 14
docking connector, identifying 17
docking support, product

description 4
drive light 12
DriveLock password 133
DriveLock, automatic 133
drives

boot order 134
preventing damage 43

DVD-ROM Drive
precautions 43
removal 65
spare part number 25, 31, 40,

65
specifications 145

DVD±RW and CD-RW SuperMulti
DL Combo Drive

precautions 43
removal 65
spare part number 25, 31, 40,

65

E
electrostatic discharge 44
eSATA/USB 2.0 combo port,

identifying 14
esc key, identifying 11
Ethernet, product description 3
Execution Disable 134
expansion memory module

removal 51
spare part number 51

ExpressCard assembly
removal 111
spare part number 111

ExpressCard blank, illustrated 29
ExpressCard board, spare part

number 38, 41
ExpressCard slot, identifying 14
external media cards, product

description 4
external monitor port 13

F
f11 recovery 149, 152
File menu 132
fingerprint reader board

removal 78
spare part number 38, 78

fingerprint reader, identifying 10
fn key, identifying 11
function button board

removal 76
spare part number 37, 76

function keys, identifying 11

G
graphics card

removal 88
spare part number 23, 37, 38,

88
graphics card heat sink, spare part

number 38
graphics, product description 1
grounding equipment and

methods 46

H
hard drive

precautions 43
product description 2
removal 60
spare part number 25, 31, 36,

60
specifications 141

hard drive bay, identifying 18
hard drive bracket, removal 62
hard drive hardware kit, spare part

number 36
hard drive recovery 149, 152
heat sink

spare part number 23
hinges, spare part number 27, 37
HP QuickLook 135
HP SpareKey enrollment 133

I
integrated numeric keypad,

identifying 11
integrated webcam light,

identifying 15
Intel HT Technology 135
internal display switch 15
internal microphones, identifying

15
inverter cover, illustrated 29

J
jacks

audio-in (microphone) 13
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audio-out (headphone) 13
network 14
RJ-11 (modem) 16
RJ-45 (network) 14

K
keyboard

product description 4
removal 67
spare part number 21, 38, 67

keypad, integrated numeric 11
keys

esc 11
fn 11
function 11
num lk 11
Windows applications 11
Windows logo 11

L
language, changing in Computer

Setup 134
latch, battery release 17
legacy support, USB 130, 134
lights

battery 12
calculator 8
caps lock 8
drive 12
mute 8
num lock 8
power 8, 12
QuickWeb 8
TouchPad 8
webcam 15
wireless 8, 12

logo nameplate
spare part number 28, 37

M
mass storage devices, spare part

number 31
Media Card Reader, identifying

12
memory module

product description 2
removal 51, 69
spare part number 36, 51, 69

microphone (audio-in) jack
product description 3

microphone board, spare part
number 37

model name 1
modem module

product description 3
removal 92
spare part number 23, 36, 92

Multi Core CPU 135
mute light, identifying 8

N
network jack, identifying 14
Northbridge chip heat plate

removal 101
num lk key, identifying 11
num lock light 8

O
operating system, product

description 5
optical drive

precautions 43
product description 3
removal 65
spare part number 25, 31, 65
specifications 142, 143, 144,

145
optical drive bracket, spare part

number 32
40

optical drive weight saver
illustrated 29

P
packing guidelines 45
parallel port mode 134
passwords 133
PCH thermal material

spare part number 40
plastic parts 42
Plastics Kit

contents 29
spare part number 29, 33, 37

pointing device, product
description 4

pointing stick 7
pointing stick buttons 7
pointing stick cover

spare part number 40
port options 137

1394 port 137

eSATA port 137
ExpressCard slot 137
flash media reader 137
parallel port 137
serial port 137
smart card slot 137
USB port 137

ports
1394 14
DisplayPort 14
eSATA/USB 2.0 combo 14
external monitor 13
product description 4
USB 2.0 14
USB 3.0 13
USB charging 14

power button board
removal 74
spare part number 37, 74

power button, identifying 9
power connector cable

illustrated 30
removal 105
spare part number 105

power connector, identifying 16
power cord

set requirements 154
spare part number 32, 35

power light 8, 12
power requirements, product

description 5
primary memory module

removal 69
spare part number 69

processor
product description 1
removal 90
spare part number 23, 90

processor heat sink
removal 86
spare part number 86

product description
audio 3
chipset 1
display panel 1
docking support 4
Ethernet 3
external media cards 4
graphics 1
hard drives 2
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keyboard 4
memory module 2
microphone 3
modem module 3
operating system 5
optical drives 3
pointing devices 4
ports 4
power requirements 5
processors 1
product name 1
security 5
serviceability 6
webcam 3
wireless 3

product name 1

Q
QuickWeb button 10
QuickWeb light 8

R
recovery partition 149, 152
removal/replacement

preliminaries 42
procedures 47

restoring
factory settings 132
hard drive 149, 152
security defaults 137

RJ-11 (modem) jack
identifying 16
spare part number 23

RJ-11 connector cable
removal 113

RJ-11 jack cover
illustrated 29

RJ-45 (network) jack, identifying
14

RJ-45 connector cable
removal 103

RTC battery
removal 53
spare part number 37, 53

Rubber Kit, spare part number 37

S
SATA (Serial Advanced

Technology Attachment)
devices 134

AHCI (Advanced Host
Controller Interface) 134

IDE (Integrated Drive
Electronics) 134

Screw Kit, spare part number 34,
37

SD Card blank, illustrated 29
Secondary Battery Fast Charge

135
Secure Digital (SD) card/USB 2.0

assembly
removal 99
spare part number 99

Secure Digital (SD) card/USB 2.0
assembly board, spare part
number 37

Secure Digital card/USB 2.0
assembly board

spare part number 25
security cable slot, identifying 14
Security menu 133

always prompt for HP
SpareKey enrollment 133

Automatic DriveLock 133
change password 133
Disk Sanitizer 133
DriveLock 133
fingerprint reader reset 133
HP Sparekey 133
HP Sparekey enrollment 133
password policy 133
set up BIOS administrator

password 133
System IDs 133

security, product description 5
service access cover

removal 50
spare part number 37, 50

service access cover latch
removal 115

service considerations 42
service tag 19, 47
serviceability, product

description 6
set security level 137

setup utility
File menu 132
navigating and selecting 130
restoring factory settings 131
Security menu 133
System Configuration menu

134
SIM slot, identifying 17
SIM, removal 49
slots

ExpressCard 14
security cable 14

smart card bracket, spare part
number 40

smart card reader
identifying 13
removal 63
spare part number 37, 63

solid-state drive, spare part
number 25, 31, 40, 41, 60

speakers
identifying 12
removal 96
spare part number 23, 37, 96

specifications
Blu-ray Disc ROM Drive 144
Blu-ray Disc ROM DVD±RW

SuperMulti DL Combo Drive
143

computer 138
display 139, 140
DVD-ROM Drive 145
DVD±RW and CD-RW

SuperMulti DL Combo
Drive 142

hard drive 141
optical drive 142, 143, 144,

145
static-shielding materials 46
system board

removal 107
spare part number 24, 37, 40,

41, 107
System Configuration menu 134
system date and time 132
system diagnostics 132
system fan 134
system IDs 133
system information 132
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T
thermal material, replacement 87
tools required 42
top cover

removal 71
spare part number 22, 37, 71

TouchPad button board
removal 80
spare part number 80

TouchPad buttons 7
TouchPad light, identifying 8
TouchPad on/off button 7, 9
TouchPad, identifying 7
TPM Embedded Security 133
transporting guidelines 45
TXT (Intel Trusted Execution

Technology) 135

U
Unified Extensible Firmware

Interface (UEFI) mode 134
upgrade bay, identifying

13
USB 3.0 ports, identifying 13
USB charging port 14
USB legacy support 130, 134
USB port, identifying 14
User management 133

V
vents, identifying 14, 17
VGA port

removal 82
spare part number 37, 82

video card fan/heat sink assembly
removal 84
spare part number 84

Virtualization Technology 135
volume mute button, identifying 9

W
webcam

identifying 15
product description 3
spare part number 37

webcam light, identifying 15
webcam module, spare part

number 28
Windows 7 operating system

DVD 149

Windows applications key,
identifying 11

Windows logo key, identifying 11
Windows Vista operating system

DVD 153
wireless antennas

disconnecting 54, 56
identifying 15

wireless button, identifying 9
wireless lights 8, 12
wireless, product description 3
WLAN antennas, identifying 15
WLAN module

removal 54
spare part number 26, 36, 54

workstation guidelines 45
WWAN antennas, identifying 15
WWAN module

removal 56
spare part number 25, 36, 56
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